Cyber-shot Handbook
DSC-G3
How to use this handbook

Click on a button at upper right to jump to the corresponding page.

Search for information by function.

Search for information by operation.

Search for information in a listing of HOME/MENU items.

Search for information by keyword.

Marks and notations used in this handbook

In this handbook, the sequence of operations is shown by arrows (→). You should touch the items on the screen in the order indicated. Marks are shown as they appear in the camera’s default setting.

The default setting is indicated by ✓.

Indicates cautions and limitations relevant to the correct operation of the camera.

Indicates information that is useful to know.
Notes on using the camera

Notes on the types of “Memory Stick” that you can use (not supplied)

“Memory Stick Duo”: You can use a “Memory Stick Duo” with the camera.

“Memory Stick”: You cannot use a “Memory Stick” with the camera.

Other memory cards cannot be used.
- For details on “Memory Stick Duo”, see page 168.

When using a “Memory Stick Duo” with “Memory Stick” compatible equipment
You can use the “Memory Stick Duo” by inserting it into the “Memory Stick Duo” Adaptor (not supplied).

Notes on the battery pack
- Charge the battery pack (supplied) before using the camera for the first time.
- You can charge the battery pack even if it is not completely discharged. In addition, even if the battery pack is not fully charged, you can use the partially charged capacity of the battery pack as is.
- If you do not intend to use the battery pack for a long time, use up the existing charge and remove it from the camera, then store it in a cool, dry place. This is to maintain the battery pack functions.
- For details on the usable battery pack, see page 170.

Carl Zeiss lens
The camera is equipped with a Carl Zeiss lens which is capable of reproducing sharp images with excellent contrast.
The lens for the camera has been produced under a quality assurance system certified by Carl Zeiss in accordance with the quality standards of Carl Zeiss in Germany.

Notes on the LCD screen and lens
- The LCD screen is manufactured using extremely high-precision technology so over 99.99% of the pixels are operational for effective use. However, some tiny black and/or bright dots (white, red, blue or green) may appear on the LCD screen. These dots are a normal result of the manufacturing process and do not affect the recording.

- If water droplets or other liquids splash on the LCD screen and make it wet, immediately wipe off the screen with a soft cloth. Leaving liquids on the LCD screen surface can harm the quality and cause a malfunction.
- Exposing the LCD screen or the lens to direct sunlight for long periods may cause malfunctions. Be careful when placing the camera near a window or outdoors.
- Do not press against the LCD screen. The screen may be discolored and that may cause a malfunction.
- Be careful not to bump the lens, and be careful not to apply force to it.

The images used in this Handbook
The images used as examples in this Handbook are reproduced images, and are not actual images shot using this camera.
# Table of contents

## Notes on using the camera

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use this handbook</td>
<td>2</td>
</tr>
<tr>
<td>Notes on using the camera</td>
<td>3</td>
</tr>
<tr>
<td>Operation Search</td>
<td>8</td>
</tr>
<tr>
<td>HOME/MENU Search</td>
<td>11</td>
</tr>
<tr>
<td>Using the touch panel</td>
<td>15</td>
</tr>
<tr>
<td>Changing the DISP (screen display) setting</td>
<td>16</td>
</tr>
<tr>
<td>Album/Photo Library Function</td>
<td>18</td>
</tr>
<tr>
<td>Network Function</td>
<td>19</td>
</tr>
</tbody>
</table>

## Shooting

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Adjustment</td>
<td>20</td>
</tr>
<tr>
<td>Scene Selection</td>
<td>21</td>
</tr>
<tr>
<td>Smile Shutter</td>
<td>23</td>
</tr>
<tr>
<td>Easy Shooting</td>
<td>24</td>
</tr>
<tr>
<td>Program Auto</td>
<td>25</td>
</tr>
<tr>
<td>Movie Mode</td>
<td>26</td>
</tr>
<tr>
<td>Zoom</td>
<td>27</td>
</tr>
<tr>
<td>Self-Timer</td>
<td>28</td>
</tr>
<tr>
<td>Macro/Close focus</td>
<td>29</td>
</tr>
<tr>
<td>Flash</td>
<td>30</td>
</tr>
<tr>
<td>Focus</td>
<td>31</td>
</tr>
<tr>
<td>Metering Mode</td>
<td>33</td>
</tr>
<tr>
<td>ISO</td>
<td>34</td>
</tr>
<tr>
<td>EV</td>
<td>35</td>
</tr>
</tbody>
</table>
# View Command

## Viewing
- Viewing still images ........................................ 37
- Image Index ......................................................... 38
- Slideshow .......................................................... 39
- Delete .................................................................. 42
- Wide Zoom .......................................................... 43
- Temporarily Rotated Display ................................. 44
- Viewing movies ..................................................... 45
- Scrapbook ........................................................... 46

## HOME
- HOME items ......................................................... 11

## MENU (Shooting)
- MENU items (Shooting) ........................................... 13

## MENU (Viewing)
- MENU items (Viewing) ........................................... 14

## Wireless LAN
- Network Settings ................................................... 117
- Web–Upload Images/Browse the Web ..................... 121
- DLNA–Be Viewed ................................................... 124
- DLNA–Send and View ............................................. 125
- Using the keyboard ............................................... 127
# Table of contents

## TV
- Viewing images on a TV ........................................ 128

## Computer
- Enjoying your Windows computer .......................... 131
- Installing the software (supplied) ......................... 133
- On “PMB (Picture Motion Browser)” (supplied) ........ 134
- Enjoying images on your computer ....................... 135
- Uploading images to a media service ...................... 139
- Using the “Music Transfer” (supplied) ................. 141
- Using your Macintosh computer ......................... 142
- Viewing “Cyber-shot Step-up Guide” .................. 145

## Printing
- Printing still images .......................................... 146
- Printing images directly using a PictBridge compliant printer ........................................ 147
- Printing at a shop ............................................... 149

## Troubleshooting
- Troubleshooting ................................................ 150
- Warning indicators and messages ...................... 161

## Others
- Using the camera abroad — Power sources ........... 167
- On the “Memory Stick Duo” ................................. 168
- On the battery pack ............................................. 170
- On the battery charger ........................................ 171
- On Cyber-shot Station ......................................... 172
## Operation Search

<table>
<thead>
<tr>
<th>Leaving the settings to the camera</th>
<th>Auto Adjustment .................................................. 20</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Scene Selection .................................................. 21</td>
</tr>
<tr>
<td></td>
<td>Scene Recognition ................................................ 78</td>
</tr>
<tr>
<td>Shooting portraits</td>
<td>Soft Snap .......................................................... 21</td>
</tr>
<tr>
<td></td>
<td>Twilight Portrait ................................................ 21</td>
</tr>
<tr>
<td></td>
<td>Smile Shutter .................................................... 23</td>
</tr>
<tr>
<td></td>
<td>Face Detection .................................................. 81</td>
</tr>
<tr>
<td></td>
<td>Anti Blink ......................................................... 91</td>
</tr>
<tr>
<td></td>
<td>Red Eye Reduction ................................................ 92</td>
</tr>
<tr>
<td>Shooting food arrangements</td>
<td>Gourmet .............................................................. 21</td>
</tr>
<tr>
<td>Shooting close to objects</td>
<td>Macro ................................................................. 29</td>
</tr>
<tr>
<td></td>
<td>Close focus enabled ............................................. 29</td>
</tr>
<tr>
<td>Shooting moving objects</td>
<td>Hi-Speed Shutter ................................................ 22</td>
</tr>
<tr>
<td></td>
<td>Burst ................................................................. 84</td>
</tr>
<tr>
<td>Shooting without blur</td>
<td>High Sensitivity ................................................ 21</td>
</tr>
<tr>
<td></td>
<td>Hi-Speed Shutter ................................................ 22</td>
</tr>
<tr>
<td></td>
<td>2-second delay self-timer ..................................... 28</td>
</tr>
<tr>
<td></td>
<td>ISO ................................................................. 34</td>
</tr>
<tr>
<td>Shooting with backlight</td>
<td>Forced Flash ..................................................... 30</td>
</tr>
<tr>
<td></td>
<td>Scene Recognition .............................................. 78</td>
</tr>
<tr>
<td>Shooting in dark places</td>
<td>High Sensitivity ................................................ 21</td>
</tr>
<tr>
<td></td>
<td>Slow Synchro .................................................... 30</td>
</tr>
<tr>
<td></td>
<td>ISO ................................................................. 34</td>
</tr>
<tr>
<td>Table of contents</td>
<td>Page</td>
</tr>
<tr>
<td>------------------</td>
<td>------</td>
</tr>
<tr>
<td>Adjusting exposure</td>
<td></td>
</tr>
<tr>
<td>Changing focus position</td>
<td></td>
</tr>
<tr>
<td>Deleting images</td>
<td></td>
</tr>
<tr>
<td>Displaying enlarged images</td>
<td></td>
</tr>
<tr>
<td>Displaying full-screen images</td>
<td></td>
</tr>
<tr>
<td>Editing images</td>
<td></td>
</tr>
<tr>
<td>Playing back a series of images in order</td>
<td></td>
</tr>
<tr>
<td>Initializing settings</td>
<td></td>
</tr>
<tr>
<td>Printing images</td>
<td></td>
</tr>
<tr>
<td>Using Wireless LAN networks</td>
<td></td>
</tr>
<tr>
<td>Viewing on TVs</td>
<td></td>
</tr>
<tr>
<td>Adjusting exposure</td>
<td>Histogram</td>
</tr>
<tr>
<td></td>
<td>EV</td>
</tr>
<tr>
<td>Changing focus position</td>
<td>Using the touch panel</td>
</tr>
<tr>
<td></td>
<td>Face Detection</td>
</tr>
<tr>
<td>Deleting images</td>
<td>Delete</td>
</tr>
<tr>
<td></td>
<td>Format</td>
</tr>
<tr>
<td>Displaying enlarged images</td>
<td>Playback zoom</td>
</tr>
<tr>
<td></td>
<td>Trimming</td>
</tr>
<tr>
<td>Displaying full-screen images</td>
<td>DISP (Screen Display)</td>
</tr>
<tr>
<td></td>
<td>Wide Zoom</td>
</tr>
<tr>
<td></td>
<td>Temporarily Rotated Display</td>
</tr>
<tr>
<td></td>
<td>Image Size</td>
</tr>
<tr>
<td>Editing images</td>
<td>Scrapbook</td>
</tr>
<tr>
<td></td>
<td>Retouch</td>
</tr>
<tr>
<td></td>
<td>Paint</td>
</tr>
<tr>
<td></td>
<td>Multi-Purpose Resize</td>
</tr>
<tr>
<td>Playing back a series of images in order</td>
<td>Slideshow</td>
</tr>
<tr>
<td>Initializing settings</td>
<td>Initialize</td>
</tr>
<tr>
<td>Printing images</td>
<td>Printing still images</td>
</tr>
<tr>
<td>Using Wireless LAN networks</td>
<td>Network Settings</td>
</tr>
<tr>
<td></td>
<td>Web–Upload Images/Browse the Web</td>
</tr>
<tr>
<td></td>
<td>DLNA–Be Viewed</td>
</tr>
<tr>
<td></td>
<td>DLNA–Send and View</td>
</tr>
<tr>
<td>Viewing on TVs</td>
<td>Viewing images on a TV</td>
</tr>
<tr>
<td>Information about optional accessories</td>
<td>“Cyber-shot Step-up Guide”</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td></td>
<td>Cyber-shot Station</td>
</tr>
</tbody>
</table>
HOME items

On the HOME screen, camera operations are organized for convenience into broad categories for selection, such as shooting, viewing and printing images.

1 Touch **HOME** to display the HOME screen.

2 Touch the desired category → desired item → **OK**

Press the shutter button halfway down to return to shooting mode.

Click on an item under “Items” in the table below to jump to the corresponding page.

### Shooting

<table>
<thead>
<tr>
<th>Items</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Shooting</td>
<td></td>
</tr>
</tbody>
</table>

### View Images 1

<table>
<thead>
<tr>
<th>Items</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Date View</td>
<td></td>
</tr>
<tr>
<td>Event View</td>
<td></td>
</tr>
<tr>
<td>Favorites</td>
<td></td>
</tr>
<tr>
<td>Folder View</td>
<td></td>
</tr>
</tbody>
</table>

### View Images 2

<table>
<thead>
<tr>
<th>Items</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Slideshow</td>
<td></td>
</tr>
<tr>
<td>Music Tool</td>
<td>Download Music</td>
</tr>
<tr>
<td>Format Music</td>
<td></td>
</tr>
<tr>
<td>Scrapbook</td>
<td></td>
</tr>
</tbody>
</table>
Print

Items
Print

Communication

Items
Network  Web–Upload Images/Browse the Web  
  DLNA–Be Viewed  
  DLNA–Send and View  
  Network Settings

Manage Memory

Items
Memory Tool  Format  
  – Memory Stick Tool  Create REC.Folder  
    Change REC.Folder
Memory Tool  Format  
  – Internal Memory Tool  Create REC.Folder  
    Change REC.Folder

Settings

Items
Main Settings  Beep  
  – Main Settings 1  Function Guide  
    Initialize  
    Calibration  
    Demo Mode
Main Settings  USB Connect  
  – Main Settings 2  LUN Settings  
    COMPONENT  
    Video Out  
    TV TYPE  
    Password Lock
Shooting Settings  AF Illuminator  
  – Shooting Settings 1  Grid Line  
    AF Mode  
    Digital Zoom
Shooting Settings  Auto Orientation  
  – Shooting Settings 2  Auto Review
Clock Settings
Language Setting

Notes
- Only the available items are displayed on the screen.
- You cannot display the HOME screen when a PictBridge connection or a USB connection is made.
You can select the various shooting functions easily from the **MENU** button.

1. Slide the lens cover to switch to shooting mode.
2. Touch **MENU** to display the Menu screen.

3. Touch the menu item → desired mode → **OK**
   
   ✌️ appears when the desired item is already selected.

In the table below, ✌️ indicates a function is available and — that it is unavailable. The icons below [Scene Selection] indicate the available Scene Selection modes. Click on an item under “Menu items” to jump to the corresponding page.

### MENU items (Shooting)

You can select the various shooting functions easily from the **MENU** button.

1. Slide the lens cover to switch to shooting mode.
2. Touch **MENU** to display the Menu screen.

3. Touch the menu item → desired mode → **OK**

   ✌️ appears when the desired item is already selected.

In the table below, ✌️ indicates a function is available and — that it is unavailable. The icons below [Scene Selection] indicate the available Scene Selection modes. Click on an item under “Menu items” to jump to the corresponding page.

<table>
<thead>
<tr>
<th>REC Mode</th>
<th>AUTO</th>
<th>PGM</th>
<th>Scene Selection</th>
<th>EASY</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Size</td>
<td>✌️</td>
<td>✌️</td>
<td>✌️</td>
<td>✌️</td>
<td>✌️</td>
</tr>
<tr>
<td>Scene Recognition</td>
<td>✌️</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Flash</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✌️</td>
<td>—</td>
</tr>
<tr>
<td>Face Detection</td>
<td>✌️</td>
<td>✌️</td>
<td>✌️</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Smile Detection Sensitivity</td>
<td>✌️</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>REC Mode</td>
<td>✌️</td>
<td>✌️</td>
<td>✌️</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>EV</td>
<td>✌️</td>
<td>—</td>
<td>✌️</td>
<td>—</td>
<td>✌️</td>
</tr>
<tr>
<td>Metering Mode</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✌️</td>
</tr>
<tr>
<td>Focus</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✌️</td>
</tr>
<tr>
<td>White Balance</td>
<td>—</td>
<td>✌️</td>
<td>✌️</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Flash Level</td>
<td>—</td>
<td>✌️</td>
<td>—</td>
<td>—</td>
<td>✌️</td>
</tr>
<tr>
<td>Anti Blink</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Red Eye Reduction</td>
<td>✌️</td>
<td>✌️</td>
<td>✌️</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>DRO</td>
<td>—</td>
<td>✌️</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Color Mode</td>
<td>—</td>
<td>✌️</td>
<td>—</td>
<td>—</td>
<td>✌️</td>
</tr>
<tr>
<td>SteadyShot</td>
<td>—</td>
<td>✌️</td>
<td>✌️</td>
<td>—</td>
<td>✌️</td>
</tr>
<tr>
<td>Shooting Settings</td>
<td>✌️</td>
<td>✌️</td>
<td>✌️</td>
<td>—</td>
<td>✌️</td>
</tr>
</tbody>
</table>

**Note**

- Only the available items are displayed on the screen.
You can select the various viewing functions easily from the MENU button.

1. Press the (Playback) button to switch to playback mode.
2. Touch MENU to display the Menu screen.
3. Touch the menu item → desired mode → OK
   ❌ appears when the desired item is already selected.

In the table below, ✓ indicates a function is available and — that it is unavailable. Click on an item under “Menu items” to jump to the corresponding page.

<table>
<thead>
<tr>
<th>Menu items</th>
<th>View Mode</th>
<th>“Memory Stick Duo” / Internal Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Date View</td>
<td>Event View</td>
</tr>
<tr>
<td>(Date List)</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>(Event List)</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>(Select Folder)</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>(View Mode)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Filter by Faces)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Slideshow)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Scrapbook)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Add / Remove Favorites)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Add / Remove Sharemark)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Retouch)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Paint)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Multi-Purpose Resize)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Delete)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Protect)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>DPOF</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Print)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Rotate)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(Volume Settings)</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Notes**
- The DPOF setting is unavailable when using the internal memory.
- Only the available items are displayed on the screen.
Using the touch panel

You can make function settings on the camera by touching buttons displayed on the screen.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Advances to the next screen.</td>
</tr>
<tr>
<td>BACK</td>
<td>Returns to the previous screen.</td>
</tr>
<tr>
<td></td>
<td>Returns to the shooting/playback mode.</td>
</tr>
<tr>
<td>▲/▼/◄/►</td>
<td>Displays the hidden items so that the items you want to set are shown on the screen.</td>
</tr>
</tbody>
</table>

Notes

• To operate the touch panel, press it lightly with your finger or the supplied paint pen. Pressing excessively hard or using a pointed object other than the supplied paint pen could damage the touch panel.
• If you touch the top right of the screen during shooting, the buttons and icons will momentarily disappear. The buttons and icons will reappear when you take your finger off the screen.

Touching the screen to set the focus

Touching the subject on the touch panel displays a frame, and then pressing the shutter button halfway down brings the frame into focus. If there is a face in the frame, in addition to the focus, the brightness and hue are also automatically optimized.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>◯</td>
<td>Face is detected at the touched position.</td>
</tr>
<tr>
<td>◯</td>
<td>Object other than a person’s face is detected.</td>
</tr>
<tr>
<td>◯ OFF</td>
<td>Cancels the function.</td>
</tr>
</tbody>
</table>

Notes

• You cannot use this function when using the digital zoom, shooting in (Close focus enabled) mode or in EASY (Easy Shooting) mode.
• You cannot use this function when (Landscape), (Twilight), (Gourmet), (Fireworks) or (Hi-Speed Shutter) mode is selected in the Scene Selection.
Changing the DISP (screen display) setting

Touch DISP on the screen to change to the display selection screen.

**Note**
- Settings other than [Brightness] should be made separately for shooting and playback.

**Display Setup**

This sets whether or not to display the operation buttons and icons on the screen.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Normal" /></td>
<td>The operation buttons and the icons are displayed.</td>
</tr>
<tr>
<td><img src="image" alt="Simple" /></td>
<td>Only the operation buttons are displayed.</td>
</tr>
<tr>
<td><img src="image" alt="Image Only" /></td>
<td>The operation buttons and the icons are not displayed.</td>
</tr>
</tbody>
</table>

**Using [Image Only] playback**

- Select an image by touching the left and right sides of the screen. When you touch the center of the screen, the buttons and icons are displayed temporarily. Touch Off on the upper right corner of the screen to return to [Image Only] display.
- In [Normal] or [Simple] display mode, touch Off to switch temporarily to [Image Only] display.
Wide Zoom

In single-image mode, still images at a 4:3 and 3:2 aspect ratio are played at a 16:9 aspect ratio. In this case the top and bottom of the image will be slightly cropped.

![Wide Zoom example](image)

**Note**
- Wide Zoom is not available for movies or 16:9 images.

Histogram

A histogram is a graph showing the brightness of an image. The graph display indicates a bright image when skewed to the right side, and a dark image when skewed to the left side.

![Histogram example](image)

**Notes**
- The histogram also appears when playing back a single image, but you cannot adjust the exposure.
- The histogram does not appear while recording movies, playing back movies, viewing vertical orientation images, rotating still images, using Temporarily Rotated Display, or using Wide Zoom (4:3, 3:2).
- A large difference in the histogram displayed during shooting and playback may occur when:
  - The flash strobes.
  - The shutter speed is slow or fast.
- The histogram may not appear for images recorded using other cameras.

Brightness

This sets the brightness of the LCD screen. When viewing images in bright outside light if [Brightness] is set to [Normal], reset to [Bright]. However, the battery power may decrease faster under such condition.

Number of Images

You can set the number of images displayed in index screen to 12 or 20 images.
The camera has approximately 4 GB* of internal memory. Even when there is no “Memory Stick Duo” inserted in the camera, you can use this internal memory to record images and enjoy viewing images shot in the past. In addition, “PMB” in the CD-ROM (supplied) lets you further enjoy images in various ways. For details on “PMB”, see the “PMB Guide”.

In addition, the camera has a built-in application “PMB Portable” that lets you easily upload images to a media service. You can also upload images with this application from a computer that does not have “PMB” installed, such as when you are traveling. For details on “PMB Portable”, see the “PMB Portable” help.

Note

- When a “Memory Stick Duo” is inserted in the camera, images are recorded on the “Memory Stick Duo”. Note that the camera cannot copy or transfer images directly between the internal memory and a “Memory Stick Duo”. Use the “PMB”.

* When measuring media capacity, 1GB equals 1 billion bytes, a portion of which is used for system management and/or application files. The capacity that a user can use is approximately 3.71GB.
Network Function

A wireless LAN function is equipped with this camera. You can access media services via an access point, or play back images using a DLNA-enabled (Digital Living Network Alliance-enabled) device on a home network.

**Accessing websites via wireless connection, and browsing and uploading images (page 121)**

This camera also supports connection to hotspot services.

**Enjoying the images using “BRAVIA” and “RoomLink” (pages 124, 125)**

You can perform operations and browse images stored on the camera using a “BRAVIA” or other DLNA-enabled device connected via a home network. You can also send images to the DLNA-enabled device for viewing.
Auto Adjustment

Allows you to shoot still images with the setting adjusted automatically.

1 Slide the lens cover to switch to shooting mode.
2 AUTO (REC Mode) → AUTO (Auto Adjustment) →

If you shoot a still image of a subject that is difficult to focus on

- The shortest shooting distance is approximately 8 cm (3 1/4 inches) (W), 50 cm (19 3/4 inches) (T) (from the lens). Shoot in the Close focus mode when you shoot a subject closer than the shooting distance.
- When the camera cannot focus on the subject automatically, the AE/AF lock indicator changes to flash slowly and the beep does not sound. Either recompose the shot or change the focus setting (page 31).

Focusing may be difficult in the following situations:
- It is dark and the subject is distant.
- The contrast between the subject and the background is poor.
- The subject is seen through glass.
- The subject is moving quickly.
- There is reflective light or shiny surfaces.
- The subject is backlit or there is a flashing light.
# Scene Selection

Allows you to shoot with preset settings according to the scene.

1. Slide the lens cover to switch to shooting mode.
2. Select the desired mode.

   To select ISO/ModelAttribute:\(\text{Auto}\) (REC Mode) \(\rightarrow\) desired mode \(\rightarrow\) **OK**

   To select \(\text{Auto}\) (REC Mode) \(\rightarrow\) SCN (Scene Selection) \(\rightarrow\) desired mode \(\rightarrow\) **OK**

<table>
<thead>
<tr>
<th>ISO (High Sensitivity)</th>
<th>Allows you to shoot images without a flash under low light conditions, reducing blur.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Landscape)</td>
<td>Allows easy shooting of distant scenes by focusing in the distance. Shoots vivid blue sky and flora colors.</td>
</tr>
<tr>
<td>(Soft Snap)</td>
<td>Allows you to shoot images with a softer atmosphere for portraits and flowers, etc.</td>
</tr>
<tr>
<td>(Twilight Portrait)</td>
<td>Allows you to shoot sharp images of people with the night view in the background without compromising the atmosphere.</td>
</tr>
<tr>
<td>(Twilight)</td>
<td>Allows you to shoot night scenes at far distance without losing the dark atmosphere of the surroundings.</td>
</tr>
<tr>
<td>(Gourmet)</td>
<td>Shifts to Macro mode, allowing you to shoot food arrangements in delicious color.</td>
</tr>
<tr>
<td>(Beach)</td>
<td>Allows you to record the blue of the water clearly when shooting seaside or lakeside scenes.</td>
</tr>
<tr>
<td>(Snow)</td>
<td>Allows you to record clear images preventing sunken colors in snowy scenes or other places where the whole screen appears white.</td>
</tr>
</tbody>
</table>

Continued
### Functions you can use in Scene Selection

For shooting an image appropriately according to the scene condition, a combination of functions is determined by the camera. ✓ indicates a function is available, and — that it is unavailable.

Some functions are not available, depending on the Scene Selection mode.

<table>
<thead>
<tr>
<th>(Fireworks)</th>
<th>Allows you to record fireworks in all their splendor.</th>
</tr>
</thead>
</table>
| (Hi-Speed Shutter) | Allows you to capture fast moving subjects outdoors or in other bright places.  
- The shutter speed becomes faster, so images shot in dark places become darker. |

**Note**

- When you shoot images using ☀ (Twilight Portrait), ☼ (Twilight) or ☪ (Fireworks) mode, the shutter speed is slower and the images tend to blur. To prevent blurring, the use of a tripod is recommended.

#### Functions You Can Use in Scene Selection

<table>
<thead>
<tr>
<th>Scene Selection</th>
<th>Macro/Close Focus</th>
<th>Flash</th>
<th>Face Detection</th>
<th>Burst/Bracket</th>
<th>White Balance</th>
<th>Red Eye Reduction</th>
<th>Anti Blink</th>
<th>Steady-Shot</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO</td>
<td>✓/—</td>
<td>☬</td>
<td>✓</td>
<td>—</td>
<td>✓*1</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>—/—</td>
<td>✓/—</td>
<td>☬/☼</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>☼/—</td>
<td>✓/—</td>
<td>✓</td>
<td>✓</td>
<td>✓*2</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>☼/—</td>
<td>✓/—</td>
<td>☬</td>
<td>✓</td>
<td>—</td>
<td>✓*1</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>☼/—</td>
<td>✓/—</td>
<td>☬/☼</td>
<td>—</td>
<td>—</td>
<td>✓*1</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>☼/—</td>
<td>✓/—</td>
<td>☬</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>—/—</td>
<td>✓/—</td>
<td>☬/☼</td>
<td>—</td>
<td>—</td>
<td>✓*1</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>


*2 [When touched] for [Face Detection] cannot be selected.
Smile Shutter

When the camera detects a smile, the shutter is released automatically.

1 Slide the lens cover to switch to shooting mode.
2 REC Mode) → AUTO (Auto Adjustment) → [X] or [OK] → (Smile icon)

3 Wait detecting a smile.
   When the smile level exceeds the point on the indicator, the camera records images automatically.
   If you press the shutter button during Smile Shutter, the camera shoots the image in Auto Adjustment, and then returns to Smile Shutter mode.

4 To stop shooting, touch (Smile icon) again.

   1 Smile Detection Sensitivity indicator
   2 Face Detection frame

Notes

• Shooting using the Smile Shutter ends automatically when either the “Memory Stick Duo” or internal memory becomes full.
• Smiles may not be detected correctly depending on the conditions.
• You cannot use the Digital Zoom function.

Hints for better capturing of smiles

• The shutter operates when any person whose face is being detected smiles. You can select the subject that has priority for face detection with [Face Detection] (page 81).
• If a smile is not detected, set the [Smile Detection Sensitivity] (page 83).

1 Do not cover the eyes with the bangs.
   Do not obscure the face by hat, masks, sunglasses, etc.
2 Try to orient the face in front of the camera and be as level as possible. Keep the eyes narrowed.
3 Give a clear smile with an open mouth. The smile is easier to detect when the teeth are showing.
Easy Shooting

Allows you shoot still images using the minimum necessary functions. The settings you can change are Image Size, Flash and Self-Timer. The text size increases and indicators become easier to see.

1 Slide the lens cover to switch to shooting mode.
2 AUTO (REC Mode) → EASY (Easy Shooting) → OK

Note
• The battery charge is used up more quickly because the screen brightness increases automatically.

Changing Image Size, Flash and Self-Timer

Image Size: MENU → select [Large] or [Small] in [Image Size]
Flash: MENU → select [Auto] or [Off] in [Flash]
Self-Timer: Øoff → select Øon (Self-Timer 10sec) or Øoff (Off)
Program Auto

Allows you to shoot with the exposure adjusted automatically (both the shutter speed and the aperture value). The setting buttons for Focus, Metering Mode, ISO and EV will appear on the bottom of the screen. Also you can select various settings using the menu.

1. Slide the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → PGM (Program Auto) → OK
Movie Mode

Allows you to record movies with audio.

1. Slide the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → (Movie Mode) → OK
3. Press the shutter button fully down.
4. To stop recording, press the shutter button fully down again.
Zoom

You can enlarge the image when shooting. The camera’s optical zoom function can enlarge images up to 4×.

1 Slide the lens cover to switch to shooting mode.
2 Press the zoom (W/T) button.
   Press the T side of the zoom (W/T) button to zoom in and press the W side to zoom out.
   • When the zoom scale exceeds 4×, see page 71.

Note
• The camera zooms slowly while shooting a movie.
Self-Timer

1. Slide the lens cover to switch to shooting mode.
2. $\text{Off}$ (Self-Timer) $\rightarrow$ desired mode $\rightarrow$ OK

| $\text{On}$ (Self-Timer 10sec) | Setting the 10-second delay self-timer  
When you press the shutter button, the self-timer lamp flashes and a beep sounds until the shutter operates.  
To cancel, touch $\text{On}$. |
| $\text{On}$ (Self-Timer 2sec) | Setting the 2-second delay self-timer |

Note

- In EASY (Easy Shooting) mode, you can select only $\text{On}$ (Self-Timer 10sec) or $\text{Off}$ (Off).

Reducing blurring with the two-second self-timer

- Use the 2-second delay self-timer to prevent blur of an image. The shutter is released 2 seconds after you press the shutter button, which reduces camera shake when the shutter button is pressed.
Macro/Close focus

Use this setting to capture beautiful close-up images of small subjects such as insects or flowers.

1 Slide the lens cover to switch to shooting mode.
2 AUTO (Macro) → desired mode → OK

| AUTO (Auto) | The camera adjusts the focus automatically from distant subjects to close-up. Normally, put the camera in this mode. |
| Macro On | The camera adjusts the focus with priority on close-up subjects. Set Macro on when shooting close subjects. |
| Close focus enabled | Use this mode to shoot at even closer distances than Macro recording. Locked to the W side: Approximately 1 to 20 cm (13/32 to 7 7/8 inches) |

Notes

- The Auto Focus speed becomes slower when you shoot images in the Macro or Close focus mode.
- You cannot use the Scene Recognition function in [Macro On] or [Close focus enabled].
- Note the following points when using the Close focus mode.
  - You cannot use the Burst, Bracket or Face Detection functions.
  - This mode is cancelled if you turn off the power or switch the shooting mode to another one.
Flash

1. Slide the lens cover to switch to shooting mode.
2. $\text{\(\text{\#AUTO}\)}$ (Flash) $\rightarrow$ desired mode $\rightarrow$ OK

| $\text{\(\text{\#AUTO}\)}$ (Flash Auto) | Flashes when there is insufficient light or backlight. |
| $\text{\(\#\)}$ (Flash On) | Flash always operates. |
| $\text{\(\# SL\)}$ (Slow Synchro) | Flash always operates. The shutter speed is slow in a dark place to clearly shoot the background that is out of flash light. |
| $\text{\(\#\)}$ (Flash Off) | Flash does not operate. |

**Notes**
- The flash strobes twice. The first flash adjusts the light quantity.
- While charging the flash, $\text{\(\#\)}$ is displayed.
- Even with flash forced on, the flash may not operate in some cases, such as during burst.
- You cannot use the flash during burst or bracket shooting.
- You cannot use $\text{\(\#\)}$ (Flash On) or $\text{\(\# SL\)}$ (Slow Synchro) when the Scene Recognition function is set to [Auto] or [Advanced].

💡 **When the “White circular spots” appears in flash photos**

This is caused by particles (dust, pollen, etc.) floating close to the lens. When they are accentuated by the camera’s flash, they appear as white circular spots.

**Camera**

![Diagram of Camera, Subject, and Particles]

**Subject**

Particles (dust, pollen, etc.) in the air

**How can the “White circular spots” be reduced?**
- Light the room and shoot the subject without a flash.
- Select $\text{\(\# 0\)}$ (High Sensitivity) mode in Scene Selection. ($\text{\(\#\)}$ (Flash Off) is automatically selected.)
- Even though you selected $\text{\(\# 0\)}$ (High Sensitivity) mode in Scene Selection, the shutter speed might be slower under low-light conditions, or in a dark place. In that case, use a tripod or hold your arms firmly at your side after pressing the shutter button.
Focus

You can change the focus method. Use the menu when it is difficult to get the proper focus in auto focus mode.
AF stands for “Auto Focus,” a function that adjusts the focus automatically.

The following steps are used in (Program Auto) mode. For details on focusing when shooting movies, see page 87.

1. Slide the lens cover to switch to shooting mode.
2. (REC Mode) → (Program Auto) → OK
3. (Focus) → desired mode → OK

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Multi AF)</td>
<td>Focuses on a subject in all ranges of the finder frame automatically. This mode is useful when the subject is not in the center of the frame. When Face Detection is set to other than [When touched], the setting is fixed to [Multi AF].</td>
</tr>
<tr>
<td>(Center AF)</td>
<td>Focuses on a subject in the center of the finder frame automatically. Using the AF lock function together, you can compose the image the way you want.</td>
</tr>
<tr>
<td>(Spot AF)</td>
<td>Focuses on an extremely small subject or a narrow area automatically. Using the AF lock function together, you can compose the image the way you want. Hold the camera steady so as not to misalign the subject and the AF range finder frame.</td>
</tr>
</tbody>
</table>
| 1.0 m/3.0 m/7.0 m/∞ (unlimited distance) | Automatically focuses quickly on the area around a previously set distance (Semi manual).  
  • Focuses on a subject in all ranges of the finder frame in Semi manual mode.  
  • This mode is useful when repeatedly shooting a subject at the same distance.  
  • This mode is useful when it is difficult to get sharp focus with automatic focusing, such as when shooting a subject through a net or window. |
When you use [Digital Zoom] or [AF Illuminator], the AF range finder frame is disabled and appears in a dotted line. In this case, the camera works to focus on the subjects at the center of the screen.

Note

Quickly choosing the priority subject

Touching the screen displays a frame, and then pressing the shutter button halfway down brings the frame into focus.
Metering Mode

Selects the metering mode that sets which part of the subject to measure to determine the exposure.

The following steps are used in (Program Auto) mode. For details on using metering modes when shooting movies, see page 86.

1. Slide the lens cover to switch to shooting mode.
2. (REC Mode)  (Program Auto)  OK
3. (Metering Mode)  desired mode  OK

<table>
<thead>
<tr>
<th>✅</th>
<th>(Multi)</th>
<th>Divides into multiple regions and measures each region. The camera determines a well-balanced exposure (Multi-pattern metering). When Face Detection is set to other than [When touched], the setting is fixed to [Multi].</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(Center)</td>
<td>Measures the center of the image, and determines the exposure based on the brightness of the subject there (Center-weighted metering).</td>
</tr>
</tbody>
</table>
| | (Spot) | Measures only a part of the subject (Spot metering).  
• This function is useful when the subject is backlit or when there is strong contrast between the subject and the background. |

Note

• The metering mode is fixed to [Multi] when you touch the screen to select the point to bring into focus.
ISO

Adjusts the luminous sensitivity.

1. Slide the lens cover to switch to shooting mode.
2. (REC Mode) → PGM (Program Auto) → OK

3. ISO (ISO) → desired number → OK

<table>
<thead>
<tr>
<th>ISO</th>
<th>(Auto)</th>
<th>Sets the ISO sensitivity automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO</td>
<td>80</td>
<td>100</td>
</tr>
<tr>
<td>You can reduce image blurring in dark locations or moving subjects by increasing ISO sensitivity (select a larger number).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notes

- You can select only from [ISO AUTO], [ISO 80] to [ISO 400] when set to Burst or Exposure Bracket.
- When shooting under bright conditions, the camera automatically enhances tones to prevent images appearing pale (Excludes when [ISO] is set to [ISO 80]).

💡 Adjusting ISO Sensitivity (Recommended Exposure Index)

ISO sensitivity is a speed rating for recording media that incorporates an image sensor that receives light. Even when the exposure is the same, images differ depending on the ISO sensitivity.

High ISO sensitivity
Records a bright image even in dark locations while increasing shutter speed to reduce blur.
However, the image tends to become noisy.

Low ISO sensitivity
Records a smoother image.
However, when the exposure is insufficient, the image may become darker.
**EV**

You can adjust the exposure manually in 1/3 EV steps in a range of –2.0 EV to +2.0 EV.

The following steps are used in (Program Auto) mode. For details on other shooting modes, see page 85.

1. Slide the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → PGM (Program Auto) → OK
3. 0EV (EV) → desired EV setting → OK

**Note**

- If you shoot a subject in extremely bright or dark conditions, or when you use the flash, the exposure adjustment may not be effective.
Adjusting the exposure for better looking images

You can create various images by adjusting the exposure and the ISO sensitivity. Exposure is the amount of light that the camera will receive when you release the shutter.

**Exposure:**
- **Shutter speed** = Length of time the camera receives light
- **Aperture** = Size of the opening allowing light to pass through
- **ISO sensitivity (Recommended Exposure Index)** = Recording sensitivity

Overexposure = too much light
Whitish image

Lower EV setting –
Correct exposure

Higher EV setting +
Underexposure = too little light
Darker image
Viewing still images

1. Press the  (Playback) button to switch to playback mode.
2. Select an image with  /  .

Viewing an enlarged image (playback zoom)

1. Touch the area you want to enlarge.
   The image is enlarged to twice the previous size, with the area you touched at the center. You can also enlarge the image by pressing the T side of the zoom (W/T) button.

2. Adjust the zoom scale and position.
   The image is further enlarged each time you touch the screen.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Adjusts the position.</td>
</tr>
<tr>
<td></td>
<td>Changes the zoom scale.</td>
</tr>
<tr>
<td></td>
<td>Turns [△/▽/◀/▶] on/off.</td>
</tr>
<tr>
<td></td>
<td>Cancels playback zoom.</td>
</tr>
</tbody>
</table>

Note

- You may not be able to play back some images shot using other cameras. Touch HOME, then select [Folder View] from  (View Images 1) to play back these images.

To save enlarged images

- You can save an enlarged image by using the trimming function. For details, see page 106.

Playback in [Image Only] mode

- Select an image by touching the left and right sides of the screen. When you touch the center of the screen, the buttons and icons are displayed temporarily.
- To enlarge an image during playback, touch the center of the screen to display the buttons and icons temporarily, then touch the portion you want to enlarge according to the procedure described above.
Image Index

Displays multiple images on the screen at the same time. To return to the single-image screen, touch the thumbnail image on the index screen.

1 Press the  (Playback) button to switch to playback mode.
2  (Image Index) → touch  to turn the pages

Changing the display format

Touch  (View Mode) to change the way images are displayed (View Mode).

-  (Date View): page 48
-  (Event View): page 49
-  (Favorites): page 50
-  (Folder View): page 51

View Mode

- If you touch  in index mode, you can set the number of images displayed in the index screen to 12 or 20 images.
Slideshow

Images are automatically played back in succession along with effects and music.

1 Press the  (Playback) button to switch to playback mode.
2 ➤ desired mode ➤ [Start]
3 Touch the screen and then touch [Exit] to end the slideshow.

Notes
• You cannot play back movies.
• Settings other than [Image] and [Filter by Faces] are stored until the next time they are changed.

Image

Selects the group of images to be shown.

<table>
<thead>
<tr>
<th>checkbox</th>
<th>Image</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ All</td>
<td>Plays a slideshow of all the still images in order.</td>
<td></td>
</tr>
<tr>
<td>This Date</td>
<td>Plays a slideshow of still images with the currently selected date range when the view mode is (Date View).</td>
<td></td>
</tr>
<tr>
<td>This Event</td>
<td>Plays a slideshow of still images in the currently selected event group when the view mode is (Event View).</td>
<td></td>
</tr>
<tr>
<td>Folder</td>
<td>Plays a slideshow of still images in the currently selected folder when the view mode is (Folder View).</td>
<td></td>
</tr>
<tr>
<td>Favorites 1 – 6</td>
<td>Plays a slideshow of still images in the currently selected Favorites number.</td>
<td></td>
</tr>
</tbody>
</table>

Filter by Faces

Narrows the selection of images to be shown based on portrait conditions.

<table>
<thead>
<tr>
<th>checkbox</th>
<th>Images are not filtered.</th>
<th>Images are filtered according to specified conditions and then displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>All people</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Children</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Infants</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smiles</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notes
• The [Filter by Faces] setting is fixed to [Off] when the view mode is set to [Folder View].
• You may not be able to use the [Filter by Faces] function with images shot using other cameras.
• Sometimes other than the intended images may be specified for display/non-display.
Effects

Selects the playback speed and mood for slideshows.

<table>
<thead>
<tr>
<th>Effects</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple</td>
<td>A simple slideshow switching still images at a preset interval. The playback interval is adjustable in [Interval] and you can thoroughly enjoy your images.</td>
</tr>
<tr>
<td>✗ Basic</td>
<td>A basic slideshow suitable for a wide range of scenes.</td>
</tr>
<tr>
<td>Nostalgic</td>
<td>A moody slideshow reproducing the atmosphere of a movie scene.</td>
</tr>
<tr>
<td>Stylish</td>
<td>A stylish slideshow proceeding at a middle tempo.</td>
</tr>
<tr>
<td>Active</td>
<td>A high-tempo slideshow suitable for active scenes.</td>
</tr>
<tr>
<td>Face 1:Basic</td>
<td>A mid-tempo slideshow suitable for various scenes that makes the most of images that include faces. Faces in still images are zoomed and multiple images are displayed together.</td>
</tr>
<tr>
<td>Face 2:Nostalgic</td>
<td>A slow, moody slideshow that makes the most of images that include faces. Faces in still images are zoomed and multiple images are displayed together.</td>
</tr>
<tr>
<td>Face 3:Stylish</td>
<td>A lively, high-tempo slideshow that makes the most of images that include faces. Faces in still images are zoomed and multiple images are displayed together.</td>
</tr>
</tbody>
</table>

Music

Specifies the music to be played during slideshows. You can select more than one background music track. Touch the panel to adjust the volume of the music with ±/±-.

<table>
<thead>
<tr>
<th>Music</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not use BGM.</td>
</tr>
<tr>
<td>Music1</td>
<td>The default setting for a [Simple] slideshow.</td>
</tr>
<tr>
<td>✗ Music2</td>
<td>The default setting for a [Basic] slideshow.</td>
</tr>
<tr>
<td>Music3</td>
<td>The default setting for a [Nostalgic] slideshow.</td>
</tr>
<tr>
<td>Music4</td>
<td>The default setting for a [Stylish] slideshow.</td>
</tr>
<tr>
<td>Music5</td>
<td>The default setting for a [Active] slideshow.</td>
</tr>
<tr>
<td>Music6</td>
<td>The default setting for a [Face 1:Basic] slideshow.</td>
</tr>
<tr>
<td>Music7</td>
<td>The default setting for a [Face 2:Nostalgic] slideshow.</td>
</tr>
<tr>
<td>Music8</td>
<td>The default setting for a [Face 3:Stylish] slideshow.</td>
</tr>
</tbody>
</table>
**Interval**

Sets the screen switching interval. The setting is fixed to [Auto] when [Simple] is not selected as the [Effects].

<table>
<thead>
<tr>
<th>Interval</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 sec</td>
<td>Sets the display interval of images for a [Simple] slideshow.</td>
</tr>
<tr>
<td>3 sec</td>
<td></td>
</tr>
<tr>
<td>5 sec</td>
<td></td>
</tr>
<tr>
<td>10 sec</td>
<td></td>
</tr>
<tr>
<td>✓ Auto</td>
<td>The interval is set to suit the selected [Effects] item.</td>
</tr>
</tbody>
</table>

**Repeat**

Turns slideshow repeat on or off.

<table>
<thead>
<tr>
<th>Repeat</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ On</td>
<td>Plays back images in a continuous loop.</td>
</tr>
<tr>
<td>Off</td>
<td>After all the images have been played back, the slideshow ends.</td>
</tr>
</tbody>
</table>

**Selecting background music**

You can transfer a desired music file from your CDs or MP3 files to the camera to play back during slideshow. To transfer music, install the “Music Transfer” software (supplied) to your computer. For details, see pages 141 and 144.

- You can record up to eight pieces of music on the camera (The eight preset pieces (Music1 – Music8) can be replaced with the ones you transferred).
- A maximum length of each music file for music playback of the camera is about 5 minutes.
- If you cannot play back a music file due to damage or other malfunctions to the file, execute [Format Music] (page 53) and transfer the music again.
Delete

Deleting images in single-image mode

1. Press the  (Playback) button to switch to playback mode.
2. Display the image you want to delete →  (Delete) → [OK]

Deleting images in index mode

1. Press the  (Playback) button to switch to playback mode.
2. Touch  (Image Index) to display in index mode.
3.  (Delete) → touch the image you want to delete → [OK]
   • Touch an image with  mark to release the  mark.

💡 You can switch between index and single-image mode when selecting images.

Touch  on the index screen to return to the single-image screen, and touch  on the single-image screen to return to index screen.
- You can also switch between index and single-image mode in [Add / Remove Favorites], [Add / Remove Sharemark], [Protect] or [DPOF].
Wide Zoom

In single-image mode, still images at a 4:3 and 3:2 aspect ratio are played at a 16:9 aspect ratio. In this case the top and bottom of the image will be slightly cropped.

1. Press the (Playback) button to switch to playback mode.
2. Touch (Wide Zoom).
3. To cancel Wide Zoom, touch (Wide Zoom) again.

Note
- Wide Zoom is not available for movies and 16:9 images.
Temporarily Rotated Display

This is used in the single-image mode to temporarily rotate an image and enlarge it on the screen.

1. Press the 🎬 (Playback) button to switch to playback mode.
2. Select the vertical orientation image → touch 🗑️ (Temporarily Rotated Display)
3. To cancel the display, touch 🗑️ (Temporarily Rotated Display) again.

**Notes**
- Temporarily rotated display is not available for movies or horizontal orientation images.
- Touching ►/◄ cancels temporarily rotated display.
Viewing movies

1. Press the (Playback) button to switch to playback mode.
2. Select a movie with ►/◄.
3. Touch ► (Playback).

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Volume control</td>
</tr>
<tr>
<td>►</td>
<td>Normal playback</td>
</tr>
<tr>
<td>■</td>
<td>Stop</td>
</tr>
<tr>
<td>►►/◄◄</td>
<td>Fast forward/fast rewind</td>
</tr>
</tbody>
</table>

**Notes**
- Movies of image size [320] are displayed in a smaller size.
- You may not be able to play back some images shot using other cameras. Touch HOME, then select [Folder View] from (View Images 1) to play back these images.

*Playback in [Image Only] mode*
- Select an image by touching the left and right sides of the screen. When you touch the center of the screen, the buttons and icons are displayed temporarily.
- When [Display Setup] is set to [Image Only], touch the right/left side of the screen during movie playback to display the next/previous image, and touch the center of the screen to display in [Normal] mode. Touch ☑ OFF to display in [Image Only] again.
Scrapbook

The camera automatically presents images against a background like a homemade photo album. You can also save images against different backgrounds.

1. HOME → ◀ (View Images 2) → [Scrapbook] →

2. Turn the page with ◀/▶.
   Touch an image to close-up the image. Touch the image again to return to the original screen.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Save</td>
</tr>
<tr>
<td>2</td>
<td>Background Select</td>
</tr>
<tr>
<td>3</td>
<td>Auto playback</td>
</tr>
<tr>
<td>4</td>
<td>Exit</td>
</tr>
<tr>
<td>5</td>
<td>Return to front cover</td>
</tr>
<tr>
<td>6</td>
<td>◀/▶</td>
</tr>
</tbody>
</table>

Notes
- Scrapbook display is not available when the [View Mode] is set to [Folder View].
- You cannot use the Scrapbook function with movies.
- Images may appear to have a bluish tint. This is not a malfunction.
To select the save method

You can save scrapbook images by the following methods.

[Save This Page]: Saves the page you are currently viewing.

[Select pages and save]: Selects and saves multiple images.
   ① Touch ▶/◀ to display the image, then touch the image to save.
   ② Repeat step ① to select more images.
   ③ Touch → → [OK].

[Save All Pages in Scrapbook]: Saves all images in the scrapbook.
Date View

Separates the images by the date. This is useful for checking when you took particular photos because the images are divided up by date.

1. HOME ➔ (View Images 1) ➔ [Date View] ➔

2. Select the date you want to display with ▲/▼.

Note
• When images recorded with other cameras cannot be played back on this camera, view the images in [Folder View].

To select the playback image by the calendar

Touch (Date List) in index mode and you can select from the date view the date on which the images you want to play back were taken.
Event View

Automatically separates images by date and frequency, and displays the images in groups.

1. **HOME** → (View Images 1) → [Event View] → OK

2. Select the event group you want to display with ▲/▼.

**Note**

- When images recorded with other cameras cannot be played back on this camera, view the images in [Folder View].

💡 **To select the playback image by the event list**

Touch ◄ (Event List) in index mode and you can select the event group containing the image you want to play back from the Event List.

You can enter a desired event name for each group using the “PMB” software (supplied). For details on entering the event name, see the “PMB Guide”.

![Event List](image1)

![Event name](image2)
Favorites

Displays images for each Favorites group in which you have registered images (page 102).

1. HOME → (View Images 1) → [Favorites] →

2. Touch the Favorites number you want to display.

Note
- When images recorded with other cameras cannot be played back on this camera, view the images in [Folder View].
Folder View

Displays images for each folder created using [Create REC.Folder] of the [Memory Tool].

1. HOME → (View Images 1) → [Folder View] → OK

2. Select the folder you want to display with ▲/▼.

On the folders

- The camera stores images in a specified folder of a “Memory Stick Duo” or the internal memory. The “101MSDCF” or “101_SONY” folder exists initially when the camera is new, and all images are recorded in it.

To select the playback folder

Touch (Select Folder) in index mode and you can select the playback folder containing the image you want to play back from the folder.

- When there is only one folder, create a recording folder.
Download Music

You can use “Music Transfer” in the CD-ROM (supplied) to add or change background music tracks.

1. HOME → (View Images 2) → [Music Tool] → OK → [Download Music] → OK

2. Make a USB connection between the camera and a computer, and add or change music files (pages 141, 144).
Format Music

You can use “Music Transfer” in the CD-ROM (supplied) to delete all the background music files stored in the camera. It can be used in cases such as when the background music files are damaged and cannot be played.

1. HOME → (View Images 2) → [Music Tool] → OK → [Format Music] → OK → [OK]

2. Restore the music preset at the factory to the camera using “Music Transfer” (page 141).
Format

Formats the “Memory Stick Duo” or the internal memory. A commercially available “Memory Stick Duo” is already formatted, and can be used immediately.

1. **HOME ➔** (Manage Memory) ➔ [Memory Tool] ➔ **OK** ➔ [Format] ➔ **OK** ➔ [OK]

**Note**

- Note that formatting permanently erases all data including even protected images.
Create REC.Folder

Creates a folder in the recording media for recording images. Images are recorded in the newly created folder until you create another folder or select another recording folder.

1. HOME → [Manage Memory] → [Memory Tool] → OK → [Create REC.Folder] → OK →

Notes

- You cannot delete a folder with the camera. To delete a folder, use your computer, etc.
- Up to 4,000 images can be stored in one folder. When the folder capacity is exceeded, a new folder is automatically created.

On the folders

- After a new folder is created, you can change the storage destination folder (page 56) and select the folder for viewing images (page 99).
Change REC.Folder

Changes the folder currently used for recording images.

1. **HOME** ➔ [Manage Memory] ➔ [Memory Tool] ➔ **OK** ➔ [Change REC.Folder] ➔ **OK**

2. Select the folder you want to record ➔ touch [OK].

**Notes**

- You cannot select the “100MSDCF” folder as a recording folder.
- You cannot move recorded images to another folder.
Beep

Selects the sound produced when you operate the camera.

1. **HOME** → 📷 (Settings) → [Main Settings] → OK → [Beep] → OK → desired mode → OK

<table>
<thead>
<tr>
<th>Shutter</th>
<th>Turns on the shutter sound when you press the shutter button.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ On</td>
<td>Turns on the beep/shutter sound when you operate the touch panel/press the shutter button.</td>
</tr>
<tr>
<td>Off</td>
<td>Turns off the beep/shutter sound.</td>
</tr>
</tbody>
</table>
## Function Guide

You can select whether or not function guide is displayed when you operate the camera.

1.  
   - **HOME** → 📷 (Settings) → [Main Settings] →  
     - **OK** → [Function Guide] → **OK** → desired mode → **OK**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Displays the function guide.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not display the function guide.</td>
</tr>
</tbody>
</table>

**Note**

- The guide is displayed during playback even if [Function Guide] is set to [Off].
Initialize

Initializes the setting to the default setting. Even if you execute this function, the images are retained.

1. HOME → (Settings) → [Main Settings] → OK → [Initialize] → OK → [OK]

Notes
- [Password Lock] is not released even if you initialize the settings.
- Be sure not to turn off the camera while initializing.
Calibration

Enables you to perform calibration when the touch panel buttons do not react at the appropriate points where you touch.

1. **HOME → (Settings) → [Main Settings] → OK → [Calibration] → OK**

2. Using the paint pen, touch the center of the × mark displayed on the screen in order.

**Notes**

- To stop the calibration process mid-way, touch [Cancel]. The adjustments made up to that point are not effected.
- If you fail to touch the right spot, the calibration is not performed. Touch the center of the × mark again.
Demo Mode

You can set whether to view a demonstration of the Smile Shutter and Scene Recognition.

1. **HOME** → 📷 (Settings) → [Main Settings] → OK → [Demo Mode] → OK → desired mode

<table>
<thead>
<tr>
<th>On</th>
<th>Demonstrates the Scene Recognition and Smile Shutter mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ Off</td>
<td>Does not perform a demonstration. Select this setting when shooting using the Smile Shutter.</td>
</tr>
</tbody>
</table>

**View a demonstration**

1. Slide the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → AUTO (Auto Adjustment) → OK
3. Point the camera at the subject.

**Scene Recognition**
When Scene Recognition is performed, the icon and a description of the recognized scene appear on the screen. When the shutter button is pressed, the image is recorded.

**Smile Shutter**
Touch 🎁 (Smile icon). The camera automatically operates the shutter when a smiling face is detected, but no image is recorded.
When 🎁 (Smile icon) is touched again, operation returns to the demonstration of Scene Recognition.

**Notes**
- [Auto Review] is fixed to [On].
- When DISP (screen display) is set to [Normal], some of the icons are not displayed on the LCD screen.
- When demonstrating the Scene Recognition mode, the setting is fixed to [Advanced] (page 78).
USB Connect

Selects the USB mode when connecting the camera to a computer or a PictBridge compliant printer using the cable for multi-use terminal.

1. **HOME** → 📚 (Settings) → [Main Settings] → OK → [USB Connect] → OK → desired mode

<table>
<thead>
<tr>
<th>☑ Auto</th>
<th>The camera recognizes automatically and sets up communication with a computer or PictBridge compliant printer (pages 135, 147).</th>
</tr>
</thead>
<tbody>
<tr>
<td>PictBridge</td>
<td>Connects the camera to a PictBridge compliant printer (page 147).</td>
</tr>
<tr>
<td>PTP/MTP</td>
<td>When you connect the camera to a computer, the AutoPlay Wizard appears, and the images in the recording folder on the camera are imported to the computer. (with Windows Vista/XP, Mac OS X)</td>
</tr>
<tr>
<td>Mass Storage</td>
<td>Establishes a Mass Storage connection between the camera and a computer or other USB device (page 135).</td>
</tr>
</tbody>
</table>

**Notes**

- If you cannot connect the camera to a PictBridge compliant printer with the [Auto] setting, select [PictBridge].
- If you cannot connect the camera to a computer or a USB device with the [Auto] setting, select [Mass Storage].
LUN Settings

Sets the display method for the recording media displayed on a computer screen or other monitor when the camera is connected with a computer or AV component using a USB connection.

1. HOME →  （Settings） → [Main Settings] → OK → [LUN Settings] → OK → desired mode

<table>
<thead>
<tr>
<th></th>
<th>Multi</th>
<th>The images both on the “Memory Stick Duo” and in the internal memory are displayed. Select this setting when you connect the camera to a computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Single</td>
<td>When the “Memory Stick Duo” is inserted into the camera, the images on the “Memory Stick Duo” are displayed; when it is not inserted, the images in the internal memory are displayed. Select this setting in cases where the images of both the “Memory Stick Duo” and the internal memory are not displayed when the camera is connected to a device other than a computer.</td>
</tr>
</tbody>
</table>

**Note**

- You must always select [Multi] when uploading images to a media service using “PMB Portable”.

COMPONENT

Selects the video signal output type from SD and HD(1080i), according to the TV connected (page 128).

1. **HOME** → (Settings) → [Main Settings] → OK → [COMPONENT] → OK → desired mode

<table>
<thead>
<tr>
<th>✔ HD(1080i)</th>
<th>Select this item to connect the camera to a 1080i-capable High Definition TV.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SD</td>
<td>Select this item to connect the camera to a TV that is not compatible with an HD(1080i) signal.</td>
</tr>
</tbody>
</table>

**Notes**

- You cannot view movies output in [HD(1080i)] signal format. Set [COMPONENT] to [SD] when viewing movies.
- When viewing Scrapbook images during output in [HD(1080i)] signal format, [COMPONENT] is automatically set to [SD].
Video Out

Sets the video signal output according to the TV color system of the connected video equipment. The TV color systems differ depending on the country and region. To view images on a TV screen, check the TV color system of the country or region of use (page 130).

1. HOME →  (Settings) → [Main Settings] → OK → [Video Out] → OK → desired mode →

<table>
<thead>
<tr>
<th>NTSC</th>
<th>Sets the video output signal to NTSC mode (e.g., for the USA, Japan).</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAL</td>
<td>Sets the video output signal to PAL mode (e.g., for Europe).</td>
</tr>
</tbody>
</table>
TV TYPE

Set to the aspect ratio of television to be connected for playback.

1. HOME → 📷 (Settings) → [Main Settings] →
   OK → [TV TYPE] → OK → desired mode →

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>16:9 Select this item to play back the images on a wide screen television.</td>
</tr>
<tr>
<td></td>
<td>4:3 Select this item to play back the images on a 4:3 ratio television.</td>
</tr>
</tbody>
</table>
Password Lock

You can set a password to prevent the playback of images in the internal memory.

1. **HOME** → **(Settings)** → **[Main Settings]** → **OK** → **[Password Lock]** → **OK**

**Setting the password lock**

1. The password setting screen appears → Input the 4-digit number of your choice → **[OK]**
2. The password re-input screen appears → Input the same 4-digit number again → **[OK]** → **[OK]**
   If you enter the incorrect number, a message window appears. Touch the message window and input the correct password number again.
3. Turn off the camera.
   Password Lock is enabled starting from the next playback.

**Entering the password and playing back images**

1. The password input screen appears → Input the password number which you originally set → **[OK]**

**Notes**

- You cannot set the password for “Memory Stick Duo” images.
- The password lock is not released even by initializing the settings.

**What to do when you have forgotten the password**

1. Slide the lens cover.
2. Press the POWER button to turn off the camera.
3. Press **(Playback)** button while pressing the W side of the zoom (W/T) button.
4. The power is now turned on, and the password release screen appears → touch **[OK]**
5. Enter the password release number (page 178) → touch **[OK]** → **[OK]**
AF Illuminator

The AF illuminator supplies fill light to focus more easily on a subject in dark surroundings. The AF illuminator emits red light allowing the camera to focus easily when the shutter button is pressed halfway, until the focus is locked. The \( \text{\textsc{on}} \) indicator appears at this time.

1. \( \text{HOME} \rightarrow \equiv \) (Settings) \( \rightarrow \) [Shooting Settings] \( \rightarrow \) \( \equiv \) [AF Illuminator] \( \rightarrow \) \( \equiv \) desired mode

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Auto</td>
<td>Uses the AF illuminator.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Does not use AF illuminator.</td>
</tr>
</tbody>
</table>

Notes

- Focus is achieved as long as the AF illuminator light reaches the subject, regardless of whether light fails to reach the center of the subject.
- You cannot use the AF illuminator when:
  - [Focus] is set to Semi manual mode.
  - \( \equiv \) (Landscape) mode, \( \equiv \) (Twilight) mode, \( \equiv \) (Fireworks) mode or \( \equiv \) (Hi-Speed Shutter) mode is selected in the Scene Selection mode.
- When you use AF illuminator, the normal AF range finder frame is disabled and a new AF range finder frame is displayed by a dotted line. AF operates with priority on subjects located near the center of the frame.
- The AF illuminator emits very bright light. Although there is no health hazard, do not look directly into the AF illuminator emitter at close range.
Grid Line

With reference to the grid lines, you can easily set a subject in a horizontal/vertical position.

1. HOME → (Settings) → [Shooting Settings] → OK → [Grid Line] → OK → desired mode →

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Displays the grid lines. The grid lines are not recorded.</td>
</tr>
<tr>
<td>✓ Off</td>
<td>Does not display the grid lines.</td>
</tr>
</tbody>
</table>
AF Mode

Selects the auto focus operation mode.

1) HOME → (Settings) → [Shooting Settings] → OK → [AF Mode] → OK → desired mode

<table>
<thead>
<tr>
<th>Single</th>
<th>Automatically adjusts the focus when you press and hold the shutter button halfway down. This mode is useful for shooting stationary subjects.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor</td>
<td>Automatically adjusts the focus before you press and hold the shutter button halfway down. This mode shortens the time needed for focusing.</td>
</tr>
</tbody>
</table>

Notes

- The battery charge is used up more quickly in [Monitor] mode than in [Single] mode.
- AF mode setting is invalid when:
  - The Scene Recognition is set to other than [Off].
  - The Face Detection function is activated.
- When [Focus] is set to Semi manual mode, [Single] is automatically selected.
Digital Zoom

Selects the digital zoom mode. The camera enlarges the image using optical zoom (up to 4×). When the zoom scale is exceeded, the camera uses either smart or precision digital zoom.

1. HOME → (Settings) → [Shooting Settings] → OK → [Digital Zoom] → OK → desired mode

<table>
<thead>
<tr>
<th>✓ Smart (❑)</th>
<th>Enlarges the image digitally within the range where the image will not be distorted, according to the image size.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precision (❑)</td>
<td>Enlarges all image sizes by the total zoom scale of approximately 8×, including the optical zoom 4×. However, note that the picture quality deteriorates when the optical zoom scale is exceeded.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not use the digital zoom.</td>
</tr>
</tbody>
</table>

Notes

- The digital zoom function does not operate when using Face Detection or when recording movies.
- The smart zoom is not available when the image size is set to [10M], [3:2(8M)] or [16:9(7M)].

Total zoom scale when using Smart zoom (including optical zoom 4×)

The supported zoom ratio differs depending on the image size.

<table>
<thead>
<tr>
<th>Size</th>
<th>Total zoom scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>5M</td>
<td>Approx. 5.6×</td>
</tr>
<tr>
<td>3M</td>
<td>Approx. 7.1×</td>
</tr>
<tr>
<td>VGA</td>
<td>Approx. 22×</td>
</tr>
<tr>
<td>16:9(2M)</td>
<td>Approx. 7.6×</td>
</tr>
</tbody>
</table>
Auto Orientation

When the camera is rotated to shoot a portrait (vertical) image, the camera records its position change and displays the image in the portrait position.

1. \[HOME \rightarrow \text{Settings} \rightarrow \text{[Shooting Settings]} \rightarrow \text{OK} \rightarrow \text{[Auto Orientation]} \rightarrow \text{OK} \rightarrow \text{desired mode} \rightarrow \text{OK}\]

| ✓ On | Records the image with the correct orientation. |
| Off | Does not use Auto Orientation. |

**Notes**
- Black is displayed to the left and right of vertical orientation images.
- Depending on the shooting angle of the camera, the orientation of the image may not be recorded correctly.
- Sometimes Auto Orientation cannot be performed when using the AC Adaptor (not supplied) and the USB / A/V / DC IN cable for multi-use terminal (not supplied).

**Rotating images after recording**
- If the orientation of an image is incorrect, you can use the [Rotate] on the MENU screen to display the image in portrait position.
Auto Review

Displays the recorded image on the screen for approximately two seconds immediately after shooting a still image.

1. HOME → (Settings) → [Shooting Settings] → OK → [Auto Review] → OK → desired mode

<table>
<thead>
<tr>
<th></th>
<th>On</th>
<th>Uses the Auto Review.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off</td>
<td>Does not use Auto Review.</td>
</tr>
</tbody>
</table>

🔧 Shooting another image without delay

- When you press the shutter button halfway down, the display of the recorded image disappears and you can shoot another image immediately, even if Auto Review is set to [On].
Clock Settings

Sets the date and time.

1. HOME → (Settings) → [Clock Settings] → OK → [Clock Settings] → OK

2. Desired date display format → → touch each item and set its numeric value → [OK]
   Midnight is indicated as 12:00 AM, and noon as 12:00 PM.

Note

- The camera does not have a feature for superimposing dates on images. By using “PMB” in the CD-ROM (supplied), you can print or save images with the date.
Language Setting

Selects the language to be used in the menu items, warnings and messages.

1. HOME → (Settings) → [Language Setting] → OK → [Language Setting] → OK → desired mode → OK
Image Size

The image size determines the size of the image file that is recorded when you take a image. The larger the image size, the more detail will be reproduced when the image is printed on large-format paper. The smaller the image size, the more images can be recorded. Select the image size that matches the way you will view your images.

1. Slide the lens cover to switch to shooting mode.
2. MENU → (Image Size) → desired mode →

When shooting still images

<table>
<thead>
<tr>
<th>Image size</th>
<th>Usage guidelines</th>
<th>LCD screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ 10M (3648×2736)</td>
<td>For prints up to A3+ size</td>
<td></td>
</tr>
<tr>
<td>✔️ 5M (2592×1944)</td>
<td>For prints up to A4 size</td>
<td></td>
</tr>
<tr>
<td>✔️ 3M (2048×1536)</td>
<td>For prints up to L/2L size</td>
<td></td>
</tr>
<tr>
<td>VGA (640×480)</td>
<td>For e-mail attachments</td>
<td>Images are displayed in 4:3 or 3:2 aspect ratio.</td>
</tr>
<tr>
<td>3:2 8M (3648×2432)</td>
<td>3:2 aspect ratio as in photo prints and postcards</td>
<td></td>
</tr>
<tr>
<td>16:9 7M (3648×2056)</td>
<td>For viewing on a high-definition TV.</td>
<td>Images will fill the entire screen.</td>
</tr>
<tr>
<td>16:9 2M (1920×1080)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note

- When you print images recorded with 16:9 aspect ratio, both edges may be cut off.

In Easy Shooting mode

<table>
<thead>
<tr>
<th></th>
<th>Shoots images in [10M] size.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large</td>
<td></td>
</tr>
<tr>
<td>Small</td>
<td>Shoots images in [3M] size.</td>
</tr>
</tbody>
</table>

76GB
When shooting movies

The larger the image size, the higher the image quality. The higher the number of frames per second, the smoother the playback image.

<table>
<thead>
<tr>
<th>Movie image size</th>
<th>Frame/Second</th>
<th>Usage guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>640(Fine) (640×480)</td>
<td>Approx. 30</td>
<td>For viewing on a TV screen (high picture quality)</td>
</tr>
<tr>
<td>640(Standard) (640×480)</td>
<td>Approx. 17</td>
<td>For viewing on a TV screen (standard picture quality)</td>
</tr>
<tr>
<td>320 (320×240)</td>
<td>Approx. 8</td>
<td>For sending as an e-mail attachment</td>
</tr>
</tbody>
</table>

Notes
- When using a “Memory Stick Duo”, movies with the size set to [640(Fine)] can be recorded to only a “Memory Stick PRO Duo”.
- This camera does not support HD recordings or playbacks for movies.

On “image quality” and “image size”

A digital image is made up of a collection of small dots called pixels. If it contains a large number of pixels, the image becomes large, it takes up more memory, and the image is displayed in fine detail. “Image size” is shown by the number of pixels. Although you cannot see the differences on the screen of the camera, the fine detail and data processing time differ when the image is printed or displayed on a computer screen.

Description of the pixels and the image size

1. Image size: 10M
   - 3648 pixels × 2736 pixels = 9,980,928 pixels
2. Image size: VGA
   - 640 pixels × 480 pixels = 307,200 pixels

Many pixels
(Fine image quality and large file size)

Few pixels
(Rough image quality but small file size)
Scene Recognition

The camera automatically detects shooting conditions, and then takes the shot.

1. Slide the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → AUTO (Auto Adjustment) →
   or OK
3. MENU → SCN (Scene Recognition) → desired mode → OK

<table>
<thead>
<tr>
<th>Scene Recognition icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not use the Scene Recognition function.</td>
</tr>
<tr>
<td>(Auto)</td>
<td>When the camera recognizes the scene, it switches to the optimal settings and shoots the image.</td>
</tr>
<tr>
<td>(Advanced)</td>
<td>When the camera recognizes the scene, it switches to the optimal settings and shoots the image. In addition, when the camera recognizes (Twilight), (Twilight Portrait), (Twilight using a tripod), (Backlight), (Backlight Portrait), (Landscape), (Macro), (Portrait), it automatically shoots another image. When the camera recognizes (Portrait), the Anti Blink function operates.</td>
</tr>
</tbody>
</table>
Notes

- Scene Recognition does not function in the following situations.
  - When shooting in Macro/Close focus enabled mode
  - During burst shooting
  - When using digital zoom
- The available flash settings are $\text{Auto}$ (Flash Auto) and $\text{Off}$ (Flash Off).
- When Face Detection function is set to [When touched], the default setting for Face Detection is set to [Auto] if Scene Recognition is set to anything other than [Off] before the screen is touched.
- $\text{Tripod}$ (Twilight using a tripod) scenes sometimes cannot be recognized in an environment where vibrations are transferred to the camera even though it is fixed on a tripod.
- Sometimes a slow shutter results when a scene is recognized as a $\text{Tripod}$ (Twilight using a tripod). Keep the camera still during shooting.
- The Scene Recognition icon appears regardless of $\text{Disp}$ (screen display) settings.
- These scenes may not be recognized depending on the situation.
- The Anti Blink function does not work when Scene Recognition is set to [Auto].

What is the Anti Blink function?

When Scene Recognition is set to [Advanced] and the subject closes their eyes while shooting, this function operates so that the camera automatically records another image immediately thereafter with the subject’s eyes open. The camera then automatically selects and displays the image with the subject’s eyes open.

When the Anti Blink function operates but the camera can record only images with the subject’s eyes closed, the message “Blinked eye detected” appears on the LCD screen. When Scene Recognition is set to [Auto], the Anti Blink function does not operate, but the message “Blinked eye detected” still appears on the LCD screen when an image with the subject’s eyes closed is recorded.
Flash (Easy Shooting)

Selects the flash setting from **MENU** in Easy Shooting mode.

1. Slide the lens cover to switch to shooting mode.
2. **AUTO** (REC Mode) → **EASY** (Easy Shooting) → **OK**
3. **MENU** → [Flash] → desired mode → **OK**

<table>
<thead>
<tr>
<th></th>
<th>Auto</th>
<th>Flash strobos when there is insufficient light or backlight.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td></td>
<td>Does not use the flash.</td>
</tr>
</tbody>
</table>
Face Detection

Selects whether to use the Face Detection function or not, and also selects the priority subject for adjusting the focus when using the function. Detects the faces of your subjects and adjusts the focus, flash, exposure, white balance and red-eye reduction settings automatically.

1. Slide the lens cover to switch to shooting mode.
2. MENU → [ ] (Face Detection) → desired mode → OK

<table>
<thead>
<tr>
<th>(When touched)</th>
<th>Detects the face when an area with a face is touched on the screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ] (Auto)</td>
<td>The camera selects a face to focus on automatically.</td>
</tr>
<tr>
<td>[ ] (Child Priority)</td>
<td>Detects and shoots with priority on child’s face.</td>
</tr>
<tr>
<td>[ ] (Adult Priority)</td>
<td>Detects and shoots with priority on adult’s face.</td>
</tr>
</tbody>
</table>

Notes

- You cannot select Face Detection in EASY (Easy Shooting) or movie mode.
- In (Program Auto) mode, the default setting for Face Detection is set to [When touched].
- The Face Detection function does not work when using the digital zoom.
- Up to 8 faces of your subjects can be detected. However, only up to 4 faces of your subjects can be detected when [ ] (Soft Snap) mode is selected in the Scene Selection mode.
- Adults and children may not be recognized correctly depending on the conditions.
- During Smile Shutter shooting, [Face Detection] is automatically set to [Auto] even if it is set to [When touched].

Choosing the priority subject

- Touch a subject to select it as the priority subject immediately, regardless of the Face Detection priority setting.
- When detecting multiple faces, the camera judges which is the main subject and adjusts the focus with priority on that subject. The Face Detection frame for the main subject is orange.
- When you press the shutter button halfway down, the Face Detection frames of subjects that are in focus turn green.
Making faces easier to detect

- Use an appropriate lighting level.
- Make sure the subjects’ faces are not hidden by hats, masks, sunglasses, etc.
- Make sure the subjects are facing the camera.
Smile Detection Sensitivity

Sets the sensitivity of the Smile Shutter function for detecting smiles.

1. Slide the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → AUTO (Auto Adjustment) → [X] or [OK]
3. MENU → 😊 (Smile Detection Sensitivity) → desired mode → [OK]

<table>
<thead>
<tr>
<th>😊 (Low)</th>
<th>Detects a big smile.</th>
</tr>
</thead>
<tbody>
<tr>
<td>😏 (Medium)</td>
<td>Detects a normal smile.</td>
</tr>
<tr>
<td>😝 (High)</td>
<td>Detects even a slight smile.</td>
</tr>
</tbody>
</table>

**Note**

- Smiles may not be detected correctly depending on the conditions.
## REC Mode

You can select Normal (single-image), Burst or Exposure Bracket as the shooting mode.

1. Slide the lens cover to switch to shooting mode.
2. Press MENU →  (REC Mode) → desired mode → OK

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Normal" /></td>
<td><strong>(Normal)</strong> Records a single image.</td>
</tr>
<tr>
<td><img src="image2" alt="Burst" /></td>
<td><strong>(Burst)</strong> Records up to 100 images in succession when you press and hold down the shutter button.</td>
</tr>
<tr>
<td>BRK±0.3EV</td>
<td>Records a series of three images with the exposure values automatically shifted (Exposure Bracket). When you cannot decide the correct exposure, shoot in the Exposure Bracket mode, shifting the exposure value. You can select the image with the best exposure afterward. The larger the bracket step value, the larger the shift of the exposure value.</td>
</tr>
<tr>
<td>BRK±0.7EV</td>
<td></td>
</tr>
<tr>
<td>BRK±1.0EV</td>
<td></td>
</tr>
</tbody>
</table>

**Notes**

- The Burst mode is not available in **EASY** (Easy Shooting) or movie mode.
- The flash is set to *(Flash Off).*
- When recording with the self timer, a series of a maximum of five images is recorded.
- The recording interval is approximately 0.62 seconds. The recording interval becomes longer, depending on the setting for the image size.
- When the battery level is low, or when the internal memory or “Memory Stick Duo” is full, the Burst stops.
- The focus, white balance, and exposure are adjusted for the first image, and these settings are also used for the other images.

- The Exposure Bracket mode is not available in **EASY** (Auto Adjustment), **EASY** (Easy Shooting) or movie mode.
- The flash is set to *(Flash Off).*
- The focus and white balance are adjusted for the first image, and these settings are also used for the other images.
- When you adjust the exposure manually, the exposure is shifted based on the adjusted brightness.
- The recording interval is the same as that for Burst mode, but becomes slower depending on the shooting conditions.
- If the subject is too bright or too dark, you may not be able to shoot properly with the selected bracket step value.
EV

You can adjust the exposure manually in 1/3 EV steps in a range of –2.0 EV to +2.0 EV.

For details on EV setting in (Program Auto) mode, see page 35.

1 Slide the lens cover to switch to shooting mode.
2  MENU → 0EV (EV) → desired EV setting →  OK

Notes

- [EV] is not available in EASY (Easy Shooting) mode.
- If you shoot a subject in extremely bright or dark conditions, or when you use the flash, the exposure adjustment may not be effective.
Metering Mode (Movie)

Selects the metering mode that sets which part of the subject to measure to determine the exposure.

For details on metering modes in PGM (Program Auto) mode, see page 33.

1. Slide the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → (Movie) → OK
3. MENU → (Metering Mode) → desired mode → OK

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>![Multi]</td>
<td>Divides into multiple regions and measures each region. The camera determines a well-balanced exposure (Multi-pattern metering).</td>
<td></td>
</tr>
<tr>
<td>![Center]</td>
<td>Measures the center of the image, and determines the exposure based on the brightness of the subject there (Center-weighted metering).</td>
<td></td>
</tr>
</tbody>
</table>
Focus (Movie)

You can change the focus method. Use the menu when it is difficult to get the proper focus in auto focus mode.

For details on focus methods in "Program Auto" (Program Auto) mode, see page 31.

1. Slide the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → 録 (Movie) → OK
3. MENU → 録 (Focus) → desired mode → OK

<table>
<thead>
<tr>
<th>(Multi AF)</th>
<th>Focuses on a subject in all ranges of the finder frame automatically. This mode is useful when the subject is not in the center of the frame.</th>
</tr>
</thead>
</table>
| ∞ (unlimited distance) | Sets the focus to unlimited distance.  
  • Use this setting to focus on all objects within the frame.  
  • This mode is useful when repeatedly shooting a subject at the same distance.  
  • This mode is useful when it is difficult to get sharp focus with automatic focusing, such as when shooting a subject through a net or window. |
White Balance

Adjusts color tones according to the surrounding light conditions. Use this function if image color appears unnatural.

1. Slide the lens cover to switch to shooting mode.
2. MENU \(\rightarrow\) WB \(\rightarrow\) (White Balance) \(\rightarrow\) desired mode

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO (Auto)</td>
<td>Adjusts the white balance automatically so that the colors appear natural.</td>
</tr>
<tr>
<td>Daylight</td>
<td>Adjusts for outdoors conditions on a fine day, evening views, night scenes, neon signs, fireworks, etc.</td>
</tr>
<tr>
<td>Cloudy</td>
<td>Adjusts for a cloudy sky or a shady location.</td>
</tr>
<tr>
<td>Fluorescent Light 1</td>
<td>[Fluorescent Light 1]: Adjusts for white fluorescent lighting.</td>
</tr>
<tr>
<td>Fluorescent Light 2</td>
<td>[Fluorescent Light 2]: Adjusts for natural white fluorescent lighting.</td>
</tr>
<tr>
<td>Fluorescent Light 3</td>
<td>[Fluorescent Light 3]: Adjusts for day white fluorescent lighting.</td>
</tr>
<tr>
<td>Incandescent</td>
<td>Adjusts for places under incandescent lamp, or under bright lighting, such as in a photo studio.</td>
</tr>
<tr>
<td>Flash</td>
<td>Adjusts for the flash conditions.</td>
</tr>
</tbody>
</table>

Notes
- You cannot select [White Balance] in AUTO (Auto Adjustment), EASY (Easy Shooting) mode.
- When shooting movies, you cannot select [Flash] in [White Balance].
- Under fluorescent lights that flicker, the white balance function may not work correctly even though you select [Fluorescent Light 1], [Fluorescent Light 2] or [Fluorescent Light 3].
- When shooting with a flash in other than [Flash] mode, [White Balance] is set to [Auto].
Effects of lighting conditions

The apparent color of the subject is affected by the lighting conditions. The color tones are adjusted automatically in the Auto Adjustment mode, but you can adjust color tones manually using the White Balance function.

<table>
<thead>
<tr>
<th>Weather/lighting</th>
<th>Daylight</th>
<th>Cloudy</th>
<th>Fluorescent</th>
<th>Incandescent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characteristics of light</td>
<td>White (standard)</td>
<td>Bluish</td>
<td>Green-tinged</td>
<td>Reddish</td>
</tr>
</tbody>
</table>
Flash Level

Adjusts the amount of flash light.

1 Slide the lens cover to switch to shooting mode.

2  

3 MENU → $\text{STD}$ (Flash Level) → desired mode →

<table>
<thead>
<tr>
<th>$-$ (−)</th>
<th>Makes the flash level lower.</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\checkmark$ $\text{STD}$ (Standard)</td>
<td></td>
</tr>
<tr>
<td>$+$ (+)</td>
<td>Makes the flash level higher.</td>
</tr>
</tbody>
</table>

Note

- Sometimes effects do not show up when the subject being shot is too bright or too dark.
## Anti Blink

Images of subjects who are not blinking can be automatically selected and saved when (Soft Snap) is selected in the Scene Selection.

1. Slide the lens cover to switch to shooting mode.
2. AUTO (REC Mode) → (Soft Snap) → OK
3. MENU → (Anti Blink) → desired mode → OK

<table>
<thead>
<tr>
<th></th>
<th>AUTO (Auto)</th>
<th>When the Face Detection function is active, the camera switches to the optimal settings when it detects that the subject’s eyes are closed, and automatically selects the images in which the subject’s eyes are open.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>OFF (Off)</td>
<td>Does not use the Anti Blink function.</td>
</tr>
</tbody>
</table>

### Notes

- Anti Blink does not function in the following situations.
  - When using the flash
  - During burst or bracket shooting
  - When Face Detection function does not work
- Sometimes Anti Blink function does not work depending on the situation.
- When Anti Blink is set to [Auto] and only images with the subject’s eyes closed are recorded, the message “Blinked eye detected” appears on the LCD screen. Shoot again as necessary.
Red Eye Reduction

The flash strobos two or more times before shooting to reduce the red-eye phenomenon when using the flash.

1. Slide the lens cover to switch to shooting mode.
2. MENU → [Red Eye Reduction] → desired mode → OK

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Auto]</td>
<td>When the Face Detection function is activated, the flash strobos automatically to reduce the red-eye phenomenon.</td>
</tr>
<tr>
<td>[On]</td>
<td>The flash always strobos to reduce the red-eye phenomenon.</td>
</tr>
</tbody>
</table>

**Notes**

- You cannot select [Red Eye Reduction] in EASY (Easy Shooting) or movie mode.
- To avoid blurring of images, hold the camera firmly until the shutter is released. It usually takes a second after you press the shutter button. Be also sure not to allow the subject to move during this period.
- Red Eye Reduction may not produce the desired effects. It depends on individual differences and conditions, such as distance to the subject, or if the subject looked away from the pre-strobe.
- If you do not use the Face Detection function, Red Eye Reduction does not work, even when you select [Auto].

**What causes the red-eye phenomenon?**

Pupils become dilated in dark environments. Flash light is reflected off the blood vessels at the back of the eye (retina), causing the “red-eye” phenomenon.

**Other ways to reduce red-eye**

- Select  (High Sensitivity) mode in Scene Selection. (The flash is turned off automatically.)
- When the eyes of the subject turn out red, correct the image with [Retouch] on the viewing menu or with the supplied software “PMB”.
The camera analyzes the shooting scene and automatically corrects the brightness and contrast to improve the image quality. DRO is an abbreviation for “Dynamic Range Optimizer,” a function that automatically optimizes the difference between light and dark parts of an image.

1. Slide the lens cover to switch to shooting mode.
2. Auto (REC Mode) → PGM (Program Auto) → OK
3. MENU → D-R (DRO standard) → desired mode

<table>
<thead>
<tr>
<th>D-R Off (Off)</th>
<th>Does not adjust.</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ D-R (DRO standard)</td>
<td>The camera automatically adjusts the brightness and contrast of the entire scene.</td>
</tr>
<tr>
<td>D-R Plus (DRO plus)</td>
<td>The camera automatically adjusts brightness and contrast of the images area-by-area.</td>
</tr>
</tbody>
</table>

**Notes**
- Depending on shooting conditions, it may not be possible to obtain correction effects.
- Note the following points when [DRO plus] is set.
  - Time is required for image processing.
  - Only [ISO AUTO] or values from [ISO 80] to [ISO 400] can be set for the ISO value.
  - When Burst or Bracket mode is selected, [DRO plus] is canceled and [DRO standard] is set.
Color Mode

You can change the brightness of the image, accompanied by effects.

1 Slide the lens cover to switch to shooting mode.
2 MENU → (Color Mode) → desired mode →

<table>
<thead>
<tr>
<th></th>
<th>(Normal)</th>
<th>Sets the image to standard color.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(Vivid)</td>
<td>Sets the image to bright and deep color.</td>
</tr>
<tr>
<td></td>
<td>(Sepia)</td>
<td>Sets the image to sepia color.</td>
</tr>
<tr>
<td></td>
<td>(B &amp; W)</td>
<td>Sets the image to black and white.</td>
</tr>
</tbody>
</table>

Notes
- You cannot select [Color Mode] in AUTO (Auto Adjustment), Scene Selection or EASY (Easy Shooting) mode.
- You can select only [Normal], [Sepia] or [B & W] when shooting movies.
SteadyShot

Selects the anti-blur mode.

1. Slide the lens cover to switch to shooting mode.
2. MENU → (SteadyShot) → desired mode → OK

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>(Shooting) Activates the anti-blur function when pressing the shutter button halfway down.</td>
</tr>
<tr>
<td>🎥</td>
<td>(Continuous) Always activates the anti-blur function. You can stabilize images even when zooming up a far subject.</td>
</tr>
<tr>
<td>🎥</td>
<td>(Off) Does not use anti-blur mode.</td>
</tr>
</tbody>
</table>

Notes

• In (Auto Adjustment), EASY (Easy Shooting) or 🍴 (Gourmet) mode, [SteadyShot] is set to [Shooting].
• For movies, you can set [Continuous] or [Off] only. The default setting is set to [Continuous].
• The battery charge is used up more quickly in [Continuous] mode than in [Shooting] mode.
Hints for preventing blur

The camera moved accidentally when you took the image. This is called “Camera shake.” On the other hand, if the subject moved when you took the image, it is called “subject blur.”

Camera shake

![Image of camera shake](image1.png)

**Cause:**
Your hands or body shake while you hold the camera and press the shutter button, and the entire screen is blurred.

**What you can do to reduce the blurring:**
- Use a tripod or place the camera on a flat surface to hold the camera steady.
- Shoot with a 2-second delay self-timer and stabilize the camera by holding your arms firmly at your side after pressing the shutter button.

Subject blur

![Image of subject blur](image2.png)

**Cause:**
Even though the camera is steady, the subject moves during the exposure so the subject looks blurred when the shutter button is pressed.

**What you can do to reduce the blurring:**
- Select (High Sensitivity) mode in Scene Selection.
- Select a higher ISO sensitivity to make the shutter speed faster, and press the shutter button before the subject moves.

- The anti-blur function is enabled in the factory default settings so that the camera shake is reduced automatically. However, this is not effective for subject blur.
- Besides, camera shake and subject blur occur frequently under low-light or slow shutter speed conditions, such as those encountered in (Twilight Portrait) or (Twilight) mode. In that case, shoot with the above tips in mind.
Date List

This feature selects the date to be played back when using Date View. Step 2 is unnecessary when [Date View] is already set.

1. Press the (Playback) button to switch to playback mode.
2. MENU → (View Mode) → (Date View) → OK
3. MENU → (Date List) → OK
4. Select the date you want to display from the calendar.
Event List

This feature selects the event group to be played back when using Event View. You can enter a desired event name for each group using the “PMB” software (supplied). For details on entering the event name, see the “PMB Guide”. Step 2 is unnecessary when [Event View] is already set.

1 Press the  (Playback) button to switch to playback mode.
2 MENU →  (View Mode) →  (Event View) → OK
3 MENU →  (Event List) → OK
4 Select the event group you want to display.
Select Folder

When multiple folders are created, this selects the folder containing the image you want to playback.
Step 2 is unnecessary when [Folder View] is already set.

1 Press the (Playback) button to switch to playback mode.

2 [MENU] → (View Mode) → (Folder View) → [OK]

3 [MENU] → (Select Folder) → [OK] → select the folder with ↑/↓ → [OK]

Viewing images across multiple folders

- When multiple folders are created and the first or last image in the folder is displayed, the following indicators appear.
  - : Moves to the previous folder
  - : Moves to the next folder
  - : Moves to either the previous or next folders
  - Touch ▶/◀ to move to the next or previous folder.
View Mode

Allows you to select the display format for viewing multiple images.

1 Press the (Playback) button to switch to playback mode.

2 MENU → (View Mode) → desired mode

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✅ (Date View)</td>
<td>Displays images by the date. Touch (Date List) to select a specific date with a calendar display.</td>
</tr>
<tr>
<td>(Event View)</td>
<td>Analyzes the dates shots and frequency, automatically organizes the images into groups and displays them. Touch (Event List) to select the event group to view.</td>
</tr>
<tr>
<td>(Favorites)</td>
<td>Displays images registered as Favorites. Touch the number of the Favorites you want to display.</td>
</tr>
<tr>
<td>(Folder View)</td>
<td>Images are displayed, organized by folders. When a recording folder is already created, touch (Select Folder) to select a folder to view.</td>
</tr>
</tbody>
</table>

**Note**

- When images recorded with other cameras cannot be played back on this camera, view the images in [Folder View].
Filter by Faces

This feature filters images and displays them.

1. Press the (Playback) button to switch to playback mode.
2. (Filter by Faces) ➔ desired mode
   ➔ OK

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Off (Off)</td>
<td>Images are not filtered.</td>
</tr>
<tr>
<td>All people</td>
<td>Images are filtered according to specified conditions and then displayed.</td>
</tr>
<tr>
<td>Children</td>
<td></td>
</tr>
<tr>
<td>Infants</td>
<td></td>
</tr>
<tr>
<td>Smiles</td>
<td></td>
</tr>
</tbody>
</table>

Notes

- When the [View Mode] is set to [Folder View], you cannot use the Filter by Faces function.
- Sometimes images are mistakenly displayed or hidden.
- Sometimes filtering cannot be performed with images shot using other cameras.
### Add / Remove Favorites

Select your favorite image and add/remove from groups as Favorites. The ☀️ mark is displayed for registered images.

**Note**
- When the [View Mode] is set to [Folder View], you cannot add or remove images as Favorites.

### Registering the currently displayed image

1. Press the ➤ (Playback) button to switch to playback mode.
2. Display the image you want to add as Favorites → MENU → ☀️ (Add / Remove Favorites) → ☀️ (This Image) → OK → touch the Favorites number to which you want to add the image → [OK]

### Selecting and registering multiple images

1. Press the ➤ (Playback) button to switch to playback mode.
2. MENU → ☀️ (Add / Remove Favorites) → ☀️ (Multiple Images) → OK → touch the Favorites number to which you want to add the image
3. Select images.
   - **In single-image mode**
     1. Touch ▶/◀ to display the image, then touch the image you want to add as Favorites.
     2. Repeat step 1.
   - **In index mode**
     1. Touch ▼/▲ to turn the pages, then touch the image you want to add as Favorites.
     2. Repeat step 1 to register more images.
4. ➤ → [OK]

**Note**
- Touch an image with ✔️ mark to release the ✔️ mark.
Adding all images in the date range or event group

1. Press the (Playback) button to switch to playback mode.
2. MENU →﹝ (View Mode) → ﹝ (Date View) or ﹝ (Event View) → OK
3. Touch ▲/▼ to select the date or event you want to register.
4. MENU → ﹝ (Add / Remove Favorites) → ﹝ (Add All in Date Range) or ﹝ (Add All in Event) → OK → touch the Favorites number to which you want to add the image → [OK]

Removing all images in the date range or event group

1. Press the (Playback) button to switch to playback mode.
2. MENU →﹝ (View Mode) → ﹝ (Date View) or ﹝ (Event View) → OK
3. Touch ▲/▼ to select a date or event for remove.
4. MENU → ﹝ (Add / Remove Favorites) → ﹝ (Remove All in Date Range) or ﹝ (Remove All in Event) → OK → touch the Favorites number from which you want to remove the image → [OK]

Removing all images in Favorites

1. Press the (Playback) button to switch to playback mode.
2. MENU →﹝ (View Mode) → ﹝ (Favorites) → OK
3. Select Favorites number for remove.
4. MENU → ﹝ (Add / Remove Favorites) → ﹝ (Remove All in Favorites) → OK → [OK]
Add / Remove Sharemark

This camera comes with the “PMB Portable” application to make it easy to upload images to a media service. You can easily find the images to be uploaded by registering them as Sharemark images.

The ☑ mark is displayed for registered images.

**Note**

- When the [View Mode] is set to [Folder View], you cannot add or remove images as Sharemark.

### Registering the currently displayed image

1. Press the  (Playback) button to switch to playback mode.

2. Display the image you want to add as Sharemark

   → **MENU** → ☑ (Add / Remove Sharemark) → ☑ (This Image) → **OK** → touch the Sharemark number to which you want to add the image → [OK]

### Selecting and registering multiple images

1. Press the  (Playback) button to switch to playback mode.

2. **MENU** → ☑ (Add / Remove Sharemark) → ☑ (Multiple Images) → **OK** → touch the Sharemark number to which you want to add the image

3. Select images.

   **In single-image mode**
   ① Touch ►/◄ to display the image, then touch the image you want to add as Sharemark.
   ② Repeat step ①.

   **In index mode**
   ① Touch ▼/▲ to turn the pages, then touch the image you want to add as Sharemark.
   ② Repeat step ① to register more images.

4. → [OK]

**Note**

- Touch an image with ✔ mark to release the ✔ mark.
Adding all images in the date range or event group

1. Press the [ ] (Playback) button to switch to playback mode.
2. [MENU] → [ ] (View Mode) → [ ] (Date View) or [ ] (Event View) → [OK]
3. Touch [ ]/[] to select the date or event you want to register.
4. [MENU] → [ ] (Add / Remove Sharemark) → [ ] (Add All in Date Range) or [ ] (Add All in Event) → [OK] → touch the Sharemark number to which you want to add the image → [OK]

Removing all images in the date range or event group

1. Press the [ ] (Playback) button to switch to playback mode.
2. [MENU] → [ ] (View Mode) → [ ] (Date View) or [ ] (Event View) → [OK]
3. Touch [ ]/[] to select a date or event for remove.
4. [MENU] → [ ] (Add / Remove Sharemark) → [ ] (Remove All in Date Range) or [ ] (Remove All in Event) → [OK] → touch the Sharemark number from which you want to remove the image → [OK]

Adding/Removing all images in Favorites

1. Press the [ ] (Playback) button to switch to playback mode.
2. [MENU] → [ ] (View Mode) → [ ] (Favorites) → [OK]
3. Select Favorites for add/remove.
4. [MENU] → [ ] (Add / Remove Sharemark) → [ ] (Add All in Favorites) or [ ] (Remove All in Favorites) → [OK] → touch the Sharemark number to/from which you want to add/remove the image → [OK]
## Retouch

Adds effects or makes corrections to a recorded image and records it as a new file. The original image is retained.

1. Press the (Playback) button to switch to playback mode.
2. MENU → (Retouch) → desired mode → OK

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Trimming** | Records the zoomed playback image. Touch set the point with ▲/▼/◄/► → select an image size to save with ◀/▶ → [OK]  
  - The quality of trimmed images may deteriorate.  
  - The image size that you can trim may vary depending on the image. |
| **Red Eye Correction** | Corrects the red-eye phenomenon caused by flash. After red eye correction is completed, touch [OK].  
  - You may not be able to correct the red-eye phenomenon depending on the image. |
| **Unsharp Masking** | Sharpens the image within a chosen frame. Touch the area (frame) of the desired image to retouch → [OK]  
  - Depending on the image, sufficient correction may not be applied and the image quality may deteriorate. |
<p>| <strong>Soft Focus</strong> | Blurs the periphery around a chosen point to signalize a subject. Touch the center point of the desired image to retouch → adjust the desired range to retouch with ◀/▶ → select level of retouch with ◀/▶ → [OK] |
| <strong>Partial Color</strong> | Surrounds a chosen point in monochrome to signalize a subject. Touch the center point of the desired image to retouch → adjust the desired range to retouch with ◀/▶ → [OK] |</p>
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>(Fisheye Lens)</strong></td>
<td>Applies a fisheye effect around a chosen point. Touch the center point of the desired image to retouch → → select level of retouch with → → [OK]</td>
</tr>
<tr>
<td><strong>(Cross Filter)</strong></td>
<td>Adds starburst effects to light sources. Adjust the desired length to retouch with → → select level of retouch with → → [OK]</td>
</tr>
<tr>
<td><strong>(Radial Blur)</strong></td>
<td>Decides the center point for expressing movement in the still image. Touch the center point of the desired image to retouch → → adjust the desired range to retouch with → → [OK]</td>
</tr>
<tr>
<td><strong>(Retro)</strong></td>
<td>Softens the image by blurring the focus and lowering the surrounding light so that it appears as if it was taken by an old camera. Adjust the desired range to retouch with → → select the level of retouch with → → [OK]</td>
</tr>
<tr>
<td><strong>(Happy Faces)</strong></td>
<td>This feature puts a smile on a person’s face. Select the level of retouch with → → [OK] Retouching may not be possible depending on the image.</td>
</tr>
</tbody>
</table>

**Notes**
- You cannot retouch movies.
- When connecting the camera to a TV, you cannot retouch images.

**Confirming retouching effects before saving images**
- You can confirm how a retouching effect will look (except for (Trimming) and (Red Eye Correction)) by touching [Preview] while you are setting the effects.
Paint

Paints or adds stamps to a still image and records it as a new file.

1 Press the  (Playback) button to switch to playback mode.

2  MENU  →  (Paint)  →  OK

3 Draw on the image using the paint pen (supplied).

4 Touch the  / button → select the saved image size → [OK]

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1      | Save   | Saves the image in VGA or 3M format in the internal memory or on a “Memory Stick Duo”.
| 2      | Pen    | Paints characters or graphics. |
| 3      | Eraser | Makes corrections. |
| 4      | Stamp  | Applies a stamp to the image. |
| 5      | Thickness/Stamps select | Select the pen or eraser thickness, or the stamp. |
| 6      | Color select | Select the color. |
| 7      | Exit   | Exits paint mode. |
| 8      | Frame  | Adds a frame. Select the desired frame with . |
| 9      | Revert | Undoes the last action. |
| 10     | Clear all | Erases all painting. |

Notes

- You cannot paint or put stamps on movies.
- When connecting the camera to a TV, you cannot paint the images.
Multi-Purpose Resize

You can change the aspect ratio and size of the shooting images, then record them as the new files.
You can convert images to the 16:9 aspect ratio for high definition viewing and to the VGA size for blog or e-mail attachments.

1 Press the  (Playback) button to switch to playback mode.

2  MENU  →  (Multi-Purpose Resize) → desired mode →  [OK]

3 Touch  /  /  /  /  to specify the area you want to trim →  [OK]

<table>
<thead>
<tr>
<th>(HDTV)</th>
<th>Changes the aspect ratio from 4:3/3:2 to 16:9 and saves as 2M size.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Blog/E-mail)</td>
<td>Changes the aspect ratio from 16:9/3:2 to 4:3 and saves as VGA size.</td>
</tr>
</tbody>
</table>

Notes
- You cannot resize movies.
- You cannot resize the images from VGA to (HDTV).
- Enlarging the image and multi resizing can reduce the image quality.
Delete

Allows you to select unwanted images for deletion.

**Note**
- You cannot delete images when the [View Mode] is set to [Favorites].

### Deleting the currently displayed image

1. Press the (Playback) button to switch to playback mode.
2. Display the image you want to delete → MENU → (Delete) → (This Image) → OK → [OK]

### Selecting and deleting multiple images

1. Press the (Playback) button to switch to playback mode.
2. MENU → (Delete) → (Multiple Images) → OK
3. Select images.
   - **In single-image mode**
     1. Touch / to display the image, then touch the image you want to delete.
     2. Repeat step 1.
   - **In index mode**
     1. Touch / to turn the pages, then touch the images you want to delete.
     2. Repeat step 1 to delete more images.
4. → [OK]

**Note**
- Touch an image with mark to release the mark.

### Deleting all images in the date range, event group or folder

1. Press the (Playback) button to switch to playback mode.
2. MENU → (View Mode) → (Date View), (Event View) or (Folder View) → OK
3. Touch / to select the date, event or folder you want to delete.
4. MENU → (Delete) → (All in Date Range), (All in Event) or (All in This Folder) → OK → [OK]
Protect

Protects recorded images against accidental erasure. The on mark is displayed for registered images.

Protecting the currently displayed image

1. Press the (Playback) button to switch to playback mode.
2. Display the image you want to protect → MENU → (Protect) → (This Image) → [OK]

Selecting and protecting multiple images

1. Press the (Playback) button to switch to playback mode.
2. MENU → (Protect) → (Multiple Images) → [OK]
3. Select images.
   In single-image mode
   ① Touch / to display the image, then touch the image you want to protect.
   ② Repeat step ①.
   In index mode
   ① Touch / to turn the pages, then touch the images you want to protect.
   ② Repeat step ① to protect more images.
4. [OK]

Note
• Touch an image with mark to release the mark.
Protecting all images in the date range, event group or folder

1. Press the (Playback) button to switch to playback mode.
2. MENU → (View Mode) → (Date View), (Event View) or (Folder View) → OK
3. Touch ▲/▼ to select the date, event or folder you want to protect.
4. MENU → (Protect) → (Set All in Date Range), (Set All in Event) or (Set All in This Folder) → OK → [OK]

Unlocking all images in the date range, event group or folder

1. Press the (Playback) button to switch to playback mode.
2. MENU → (View Mode) → (Date View), (Event View) or (Folder View) → OK
3. Touch ▲/▼ to select the date, event or folder you want to unlock.
4. MENU → (Protect) → (Remove All in Date Range), (Remove All in Event) or (Remove All in This Folder) → OK → [OK]

Protecting/unlocking all images in Favorites

1. Press the (Playback) button to switch to playback mode.
2. MENU → (View Mode) → (Favorites) → OK
3. Select Favorites to set/unlock the protection.
4. MENU → (Protect) → (Set All in This Group) or (Remove All in Favorites) → OK → [OK]
DPOF

DPOF (Digital Print Order Format) is a function allowing you to make a DPOF (Print order) mark on images of “Memory Stick Duo” that you want to print out later. The DPOF mark is displayed for registered images.

Notes
- You cannot mark movies.
- You can add a DPOF (Print order) mark to a maximum 999 images.
- You cannot add a DPOF (Print order) mark to images in the internal memory.

Order printing the currently displayed image

1. Press the  (Playback) button to switch to playback mode.
2. Display the image you want to order print →
   MENU → DPOF → DPOF (This Image) → OK

Selecting and order printing multiple images

1. Press the  (Playback) button to switch to playback mode.
2. MENU → DPOF → DPOF (Multiple Images) → OK
3. Select images.
   - In single-image mode
     ① Touch  to display the image, then touch the image you want to order print.
     ② Repeat step ①.
   - In index mode
     ① Touch  to turn the pages, then touch the images you want to order print.
     ② Repeat step ① to order print more images.
4. → [OK]

Note
- Touch an image with  mark to release the  mark.
**Order printing all images in the date range, event group or folder**

1. Press the  (Playback) button to switch to playback mode.
2. `MENU` → ` Operate (View Mode)` → `Operate (Folder View)` → OK
3. Touch to select the date, event or folder you want to order print.
4. `MENU` → `DPOF` → `DPOF` (Set All in Date Range), `DPOF` (Set All in Event) or `DPOF` (Set All in This Folder) → OK → [OK]

**Cancel print order of all images in the date range, event group or folder**

1. Press the  (Playback) button to switch to playback mode.
2. `MENU` → `Operate (View Mode)` → `Operate (Folder View)` → OK
3. Touch to select the date, event or folder you want to cancel.
4. `MENU` → `DPOF` → `DPOF` (Remove All in Date Range), `DPOF` (Remove All in Event) or `DPOF` (Remove All in This Folder) → OK → [OK]

**Set/cancel print order of all images in Favorites**

1. Press the  (Playback) button to switch to playback mode.
2. `MENU` → `Operate (View Mode)` → `Operate (Favorites)` → OK
3. Select Favorites to set/cancel print order.
4. `MENU` → `DPOF` → `DPOF` (Set All in This Group) or `DPOF` (Remove All in Favorites) → OK → [OK]
Rotate

Rotates a still image.

1. Press the (Playback) button to switch to playback mode.
2. Display the image to be rotated.
3. MENU → (Rotate) → OK
4. → [OK]

Notes

- You cannot rotate movies or protected still images.
- You may not be able to rotate images shot with other cameras.
- When viewing images on a computer, the image rotation information may not be reflected depending on the software.
Volume Settings

Adjusts the volume for slideshow and movie playback.

1  Press the (Playback) button to switch to playback mode.

2  MENU → (Volume Settings) → OK

3  Adjust the volume by touching / → [Exit]

Adjusting the volume during playback of a movie or slideshow

Movie playback: Touch to display the volume control screen, then touch the / buttons to adjust the volume. Touch [Exit] to turn off the volume control screen.

Slideshow: Touch the screen to display the volume control screen, then touch the / buttons to adjust the volume. Touch BACK to turn off the volume control screen.
Network Settings

A wireless LAN function is equipped with this camera. Connect the camera to a network via an access point. The time zone and access point need to be configured before the operation.

1. HOME → 🌐 (Communication) → [Network] → OK → [Network Settings] → OK → desired item

<table>
<thead>
<tr>
<th>Access Point</th>
<th>Creates and saves the access point connection settings.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nickname</td>
<td>Enters the camera nickname displayed by the device you want to connect with.</td>
</tr>
<tr>
<td>Network Power Save</td>
<td>Sets whether to reduce power consumption when uploading images or browsing the Web.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Selects the region in which you live.</td>
</tr>
<tr>
<td>Initialize</td>
<td>Resets the network settings.</td>
</tr>
<tr>
<td></td>
<td>• Bookmark and address book settings are not reset.</td>
</tr>
</tbody>
</table>

Notes
• Network device connections and setting methods differ according to the device.
• Set [Network Power Save] to [Off] in the following cases:
  – When you cannot connect to an access point
  – When trouble occurs in the network connection
• The following are needed to connect the camera to a network:
  – An internet service provider (ISP) contract
  – ADSL modem or other network device
  – Access point or wireless router
  – Access point setting information (SSID)
• The nickname set does not always display correctly depending on the device being sent to.

Area settings for time-zone

Time zones are divided into the following regions.
Access Point

Set the access point to use the network function of this camera. The network setting method differs according to the network environment. An example of settings for a home network is described here.

1. **HOME** → 🌐 (Communication) → [Network] → [Network Settings] → [Access Point] → [Create New] → [Auto Scan] → select the access point you want to use

   The SSID information confirmation screen is displayed.

2. Confirm the SSID is displayed

   If the SSID is not displayed, select [SSID] input using the keyboard

3. Select the desired encryption type

   If you have selected [Disable], proceed to Step 5.

4. [Encryption Key] → input the encryption key using the keyboard

5. [Easy] → check your connection name → check your settings on the confirmation screen → [Save] → [OK]

   - To make detailed settings, select [Custom].
   - To change the connection name, touch [Connection Name] and input using the keyboard.

**Note**

- Certain access points may require your MAC address to be registered onto the access point to connect to the network. For details, refer to the administrator of your access point.
<table>
<thead>
<tr>
<th>Setting items</th>
<th>Description</th>
</tr>
</thead>
</table>
| Connection Name  | Input the name to be displayed on the wireless network.  
• The same name as the SSID is displayed before this setting is made.                  |
| SSID             | Input the name for identifying the wireless network.  
• If [Auto Scan] is selected, the name will be automatically retrieved.                  |
| Encryption Type  | Select the encryption type from the following list according to access point settings.  
(Disable, WEP, WPA-PSK(AES), WPA-PSK(TKIP), or WPA2-PSK(AES))                                      |
| Encryption Key   | Input the encryption key for security according to access point settings.  
• There are restrictions such as number of characters on the encryption key.             |
| IP Address       | Select [Auto] or [Manual].  
• If you select Manual, input the fixed address.                                         |
| PPPoE            | If you are using PPPoE, user authentication and IP address assignment are possible over the LAN.  
• An ID and password are required to use this feature.                                    |
| Subnet Mask      | If setting the IP address manually, input it according to server settings.                                                                   |
| Gateway          | If setting the IP address manually, input it according to server settings.                                                                   |
| Primary DNS      | Select [Auto] or [Manual].  
• If setting the IP address manually, input it according to server settings.                                                                |
| Secondary DNS    | Select [Auto] or [Manual].  
• If setting the IP address manually, input it according to server settings.                                                                |
| Proxy            | Select [Disable] or [Enable].  
• If [Enable] is set, input the proxy server, HTTP port, HTTPS port, etc.                                                               |

**Delete or confirm the access point**

[Delete] and [Details] can be displayed by touching MENU. These items allow you to delete access points or confirm setting details.
# On Encryption key

The number of characters and numbers allowed for the encryption key differs depending on the encryption type and input characters.

<table>
<thead>
<tr>
<th>Encryption Type</th>
<th>Hexadecimal input</th>
<th>Character input</th>
</tr>
</thead>
<tbody>
<tr>
<td>WEP</td>
<td>10 characters or 26 characters 0 – 9, A – F or a – f, can be used.</td>
<td>Five characters or 13 characters consisting of single-byte alphanumeric and symbol characters can be used. Uppercase and lowercase characters are treated as separate characters.</td>
</tr>
<tr>
<td>WPA-PSK(AES), WPA-PSK(TKIP), WPA2-PSK(AES)</td>
<td>64 characters 0 – 9, A – F or a – f, can be used.</td>
<td>Eight to 63 characters consisting of single-byte alphanumeric and symbol characters can be used. Uppercase and lowercase characters are treated as separate characters.</td>
</tr>
</tbody>
</table>

Example when WEP is selected: Hexadecimal input: “4506960251”, “F3BDC614D9”, etc. Character input: “9Kp3xsDFhAL4V”, etc.
Web–Upload Images/Browse the Web

You can access media services via an access point to upload images or browse the Web. This section describes operations using a home network.

1 Make sure there is a usable access point nearby.

2 HOME → [Communication] → [Network] → OK → [Upload Images/Browse the Web] → OK

3 Touch [Connect].
   The internet browser starts up.
   The default setting displays the Sony portal site.

4 Log in to a media service.

5 Upload images according to the on-screen instructions.

Notes
• When connecting to the internet, the previously used access point is automatically selected.
• Some media services may not operate correctly.
• You must create an account at the website for each media service in advance.
• The number of images that can be uploaded at once differs depending on the media service.
• It may not be possible to upload some images due to the size of the still image. In addition, the maximum movie size that can be uploaded is 100 MB.
• Operation may become slower if you remove or insert the “Memory Stick Duo” while connected to the network.
• Be sure to use sufficiently charged batteries while connected to the network.

On the WLAN (wireless network) button

You can start the internet browser by pressing the WLAN (wireless network) button while the camera’s power is on.

Connecting to a different access point than last time

1 HOME → [Communication] → [Network] → OK → [Upload Images/Browse the Web] → OK

2 [Access pt. to connect to] → access point you want to use → OK → [Connect]
## Closing the browser

1. Press the WLAN (wireless network) button, or touch $\times \rightarrow [\text{OK}]$.

## Operation buttons on the internet browser

### Button 1

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Switches screen display</td>
</tr>
<tr>
<td></td>
<td>Displays Sony portal site</td>
</tr>
<tr>
<td></td>
<td>Next/Previous page</td>
</tr>
<tr>
<td></td>
<td>Update/Cancels loading data</td>
</tr>
<tr>
<td></td>
<td>Scroll key</td>
</tr>
<tr>
<td></td>
<td>Zoom in/zoom out</td>
</tr>
<tr>
<td></td>
<td>Closes the browser</td>
</tr>
</tbody>
</table>

### Button 2

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Switches screen display</td>
</tr>
<tr>
<td></td>
<td>URL display</td>
</tr>
<tr>
<td></td>
<td>You can enter a URL address manually by touching the tab.</td>
</tr>
<tr>
<td></td>
<td>You can display the URL history by touching $\Rightarrow$.</td>
</tr>
<tr>
<td></td>
<td>Jump</td>
</tr>
<tr>
<td></td>
<td>Enter a URL address manually, then touch this button. The screen is moved to the specified website.</td>
</tr>
<tr>
<td></td>
<td>Displays HOME</td>
</tr>
<tr>
<td></td>
<td>You can return to the default Web page.</td>
</tr>
<tr>
<td></td>
<td>Search</td>
</tr>
<tr>
<td></td>
<td>You can search text within the browser.</td>
</tr>
<tr>
<td></td>
<td>Bookmark list</td>
</tr>
<tr>
<td></td>
<td>Displays history</td>
</tr>
<tr>
<td></td>
<td>Switch Tab</td>
</tr>
<tr>
<td>Button</td>
<td>Action</td>
</tr>
<tr>
<td>--------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 📡 | Address Book registration and display  
  - You can confirm registered addresses when sending an e-mail, etc. |
| 🌐 | Web Browser Settings |

### Web Browser Setting items

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Action Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Mode Settings</td>
<td>Sets the Web browser display mode.</td>
</tr>
<tr>
<td>Text Size</td>
<td>Sets the text size to be displayed.</td>
</tr>
<tr>
<td>Character Encoding</td>
<td>Selects the character encoding to be used.</td>
</tr>
<tr>
<td>Home Page</td>
<td>Sets the home page to be displayed.</td>
</tr>
<tr>
<td>Proxy</td>
<td>Sets whether a proxy is used.</td>
</tr>
<tr>
<td>Cookie</td>
<td>Sets whether to accept cookies.</td>
</tr>
<tr>
<td>Cache</td>
<td>Sets whether to use a cache.</td>
</tr>
<tr>
<td>Web Browser Information</td>
<td>Displays browser information for this device.</td>
</tr>
<tr>
<td>Security</td>
<td>Verifies encryption settings and authentication certificate.</td>
</tr>
</tbody>
</table>
DLNA–Be Viewed

Operate the DLNA-enabled “BRAVIA” via the home network and set the camera so that images stored in the camera can be viewed.

1. HOME → [Communication] → [Network] → OK → Be Viewed → OK

2. Touch [Connect].
   - If there are multiple access points, touch [Access pt. to connect to] to select the access point.

3. Select the image to be shared on the network.
4. Select the sharing method.

**Notes**
- You can share only still images.
- You can select up to 100 images at a time.
- To view the images with a DLNA-enabled device, setup and some operations of a playback device are required. For details, see the operating manual of the playback device.
- Be sure to use sufficiently charged batteries while connected to the network.

**Canceling one image to be shared**

1. Touch the image during sharing to remove the checkmark.

**Canceling all images to be shared**


**Exiting image sharing**

1. Press the WLAN (wireless network) button, or touch MENU → [Exit] → OK → [OK].
DLNA–Send and View

Operate the camera over your home network to send images to a “BRAVIA” that supports a renderer function.

1. HOME → 🌐 (Communication) → [Network] → OK → 📷 (Send and View) → OK

2. Touch [Search ext. devices].
   
   The camera searches for connectable devices. Detected devices are displayed on the LCD screen.
   
   To connect to the same device as previously, touch [Last Connected Device] → go to step 4.

3. Touch the device you want to connect with.

   🔄: Last-connected device

4. Select the image you want to send.

5. Touch the image to be sent.

Notes

- Device names are displayed in the order that the devices respond to the camera.
- Images can only be played on equipment that supports a renderer function. For details on renderer settings, refer to the “BRAVIA” instruction manual.
- Be sure to use sufficiently charged batteries while connected to the network.
Sending multiple images at the same time (Slideshow)

Using slideshow is useful when you want to send multiple images at once.

1 Touch (Slideshow) in index mode while the connection is made.

2 Touch the image you want to begin the slideshow from.
   The camera sends images to the device in order.

**Note**
- You may not be able to use the slideshow function depending on the device.

**Changing the slideshow settings**

1 Touch (Slideshow) → OK → desired item → desired setting → OK in index mode.

2 Touch [OK].
   - Set the following items:
     - Interval Settings (Fast/Normal/Slow)
     - Repeat (On/Off)
   - The interval differs depending on the image size and the client devices.

**To stop sending images**

1 Press the WLAN (wireless network) button, or touch MENU → (Exit) → OK → [OK].
Using the keyboard

When manual character input is needed, touch the input field to display the keyboard screen.

1. Operate the touch panel using paint pen.
2. When you are finished with input, touch on the bottom right of the screen.

Note
- The input language is the display language of the camera.
Viewing images on a TV

You can view images on a TV by connecting the camera to a TV. The connection varies according to the type of TV the camera is connected to. See “TV TYPE” (page 66). Refer also to the operating instructions supplied with the TV.

Viewing images by connecting the camera to a TV with the supplied cable for multi-use terminal

Turn off both the camera and the TV before connecting the camera to the TV.

1 Connect the camera to the TV with the cable for multi-use terminal (supplied).

2 Turn on the TV and set the input.

3 Press  (Playback) button to turn on the camera.

Images shot with the camera appear on the TV. Touch  to select the desired image.

Notes

- If your TV has stereo input jacks, connect the audio plug (black) of the cable for multi-use terminal to the left audio jack.
- Icons and other indicators do not appear on the TV screen.
- When using the camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 65).
- Output to a TV is not possible while connected to the network.
Viewing an image by connecting the camera to an HD TV

You can view an image recorded on the camera by connecting the camera to an HD (High Definition) TV with the HD Output Adaptor Cable (not supplied). Turn off both the camera and the TV before connecting the camera to the TV.

1 Connect the camera to an HD (High Definition) TV with a HD Output Adaptor Cable (not supplied).

2 Turn on the TV and set the input.

3 Press (Playback) button to turn on the camera.
   Images shot with the camera appear on the TV. Touch ▶◀▶ to select the desired image.

Notes
- Set [COMPONENT] to [HD(1080i)] (page 64).
- Images shot in [VGA] image size cannot be played back in HD format.
- You cannot view movies output in [HD(1080i)] signal format. Set [COMPONENT] to [SD] when viewing movies.
- When viewing Scrapbook images during output in [HD(1080i)] signal format, [COMPONENT] is automatically set to [SD].
- When using the camera abroad, it may be necessary to switch the video signal output to match that of your TV system (page 65).
- Output to a TV is not possible while connected to the network.

Viewing images with 4:3 or 3:2 aspect ratio full screen on an HD (High Definition) TV
- With [Multi-Purpose Resize], the aspect ratio can be converted to 16:9 for high definition viewing (page 109).
On “PhotoTV HD”

This camera is compatible with the “PhotoTV HD” standard. By connecting Sony PhotoTV HD-compatible devices using an HD Output Adaptor Cable (not supplied), whole new world of photos can be comfortably enjoyed in breathtaking Full HD quality.
- PhotoTV HD allows for a highly-detailed, photo-like expression of subtle textures and colors.
- The settings are also required to be made on the TV. For details, refer to the operating instruction of the TV.

On TV color systems

If you want to view images on a TV screen, you need a TV with a video input jack and the cable for multi-use terminal. The color system of the TV must match that of the digital still camera. Check the following lists for the TV color system of the country or region where the camera is used.

NTSC system
Bahama Islands, Bolivia, Canada, Central America, Chile, Colombia, Ecuador, Jamaica, Japan, Korea, Mexico, Peru, Surinam, Taiwan, the Philippines, the U.S.A., Venezuela, etc.

PAL system
Australia, Austria, Belgium, China, Czech Republic, Denmark, Finland, Germany, Holland, Hong Kong, Hungary, Italy, Kuwait, Malaysia, New Zealand, Norway, Poland, Portugal, Singapore, Slovak Republic, Spain, Sweden, Switzerland, Thailand, United Kingdom, etc.

PAL-M system
Brazil

PAL-N system
Argentina, Paraguay, Uruguay

SECAM system
Bulgaria, France, Guiana, Iran, Iraq, Monaco, Russia, Ukraine, etc.
Enjoying your Windows computer

For details on using a Macintosh computer, refer to “Using your Macintosh computer” (page 142).

Install the software (supplied) first (page 133)

- Installing the software as follows:
  - “PMB”
  - “Music Transfer”

Connecting the camera to your computer (page 135)

- Enjoying images using “PMB” and “Music Transfer” as follows:
  - Importing images to your computer
  - Exporting images to the camera
  - Entering the desired event name to [Event List] on the camera
  - Editing images
  - Displaying the shooting locations of still images on maps online (this requires an Internet connection)
  - Creating a disc with the images shot (requires CD or DVD disc writing drive)
  - Printing or saving still images with the date
  - Uploading images to a media service (this requires an Internet connection)
  - Adding/ Changing Music for slideshow (using “Music Transfer”)

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.
http://www.sony.net/
Recommended computer environment

The following environment is recommended for a computer connected to the camera.

**Recommended environment for importing images**

**OS (pre-installed):** Microsoft Windows 2000 Professional SP4, Windows XP* SP3/Windows Vista SP1*
- Operation is not assured in an environment based on an upgrade of the operating systems described above or in a multi-boot environment.

**USB jack:** Provided as standard

**Recommended environment for using “PMB” and “Music Transfer”**

**OS (pre-installed):** Microsoft Windows 2000 Professional SP4, Windows XP* SP3/Windows Vista SP1*

**CPU:** Intel Pentium III 500 MHz or faster (Recommended: Intel Pentium III 800 MHz or faster)

**Memory:** 256 MB or more (Recommended: 512 MB or more)

**Hard Disk:** Disk space required for installation—approximately 400 MB

**Display:** Screen resolution: 1,024 × 768 dots or more

* 64-bit editions and Starter (Edition) are not supported.

**Notes**

- The computer environment must also satisfy the operating requirements of the OS.
- Operations are not guaranteed for all the recommended computer environments mentioned above.
- If you connect two or more USB devices to a single computer at the same time, some devices, including the camera, may not operate, depending on the types of USB devices you are using.
- Operations are not guaranteed when using a USB hub.
- Connecting the camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as the camera is compatible with Hi-Speed USB (USB 2.0 compliant).
- There are four modes for a USB connection when connecting a computer, [Auto] (default setting), [Mass Storage], [PictBridge] and [PTP/MTP] modes. This section describes the [Auto] and [Mass Storage] as examples. For details on [PictBridge] and [PTP/MTP], see page 62.
- When your computer resumes from a suspend or sleep mode, communication between the camera and your computer may not recover at the same time.
Installing the software (supplied)

You can install the software (supplied) using the following procedure.
• Log on as Administrator.

1 Turn on your computer, and insert the CD-ROM (supplied) into the CD-ROM drive.
   The installation menu screen appears.
   • If it does not appear, double-click [Computer] (in Windows XP/2000, [My Computer]) → (SONYPICUTIL).
   • The AutoPlay screen may appear. Select “Run Install.exe.” and follow the instructions that appear on the screen to proceed with the installation.

2 Click [Install].
   The “Choose Setup Language” screen appears.

3 Select the desired language, then click [Next].
   The “License Agreement” screen appears.

4 Read the agreement carefully. If you accept the terms of the agreement, click the radio button next to [I accept the terms of the license agreement] and then click [Next].

5 Follow the instructions on the screen to complete the installation.
   • When the restarting confirmation message appears, restart the computer following the instructions on the screen.
   • DirectX may be installed depending on the system environment of your computer.

6 Remove the CD-ROM after the installation is complete.
   • Installing software as follows:
     – PMB
     – Music Transfer

| Double-click to start “PMB”.
| Double-click to start “PMB Guide”.
| Double-click to start “Music Transfer”.

After you install the software, the short cut icons for “PMB”, “PMB Guide”, “Music Transfer” are created on the desktop.
On “PMB (Picture Motion Browser)” (supplied)

You can use still images and movies from the camera more than ever by taking advantage of the software. This section summarizes the “PMB”. For details, see the “PMB Guide”.

“PMB” overview

With the “PMB”:
- You can import images shot with the camera and display them on the computer.
- You can export images in your computer to the camera, and display them on the camera.
- You can enter the desired event name to [Event List] in the camera, and display them on the camera.
- You can organize images on the computer on a calendar by shooting date to view them.
- You can retouch (Red Eye Correction, etc.), search for faces, print, send still images as e-mail attachments, and change the shooting date.
- You can display information on the positions where you shot the images on a map. (This requires an Internet connection.)
- You can print or save the still images with the date.
- You can create a data disc using a CD burner drive or DVD burner drive.
- You can upload the image to a media service. (This requires an Internet connection.)

Starting the “PMB Guide”

Double-click the  (PMB Guide) icon on the desktop.
To access “PMB Guide” from the Start menu, click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Help] → [PMB Guide].

Starting and exiting the “PMB”

Starting the “PMB”
Double-click the  (PMB) icon on the desktop.
Or, from the Start menu: Click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [PMB].
- The confirmation message of the Information tool appears on the screen when starting the “PMB” for the first time. Select [Start]. This function informs you of news, such as software updates. You can change the setting later.

Exiting the “PMB”
Click button on the top right corner of the screen.
Enjoying images on your computer

For details on the “PMB” functions, see the “PMB Guide”.

Connecting the camera to the computer

1 Insert the sufficiently charged battery pack into the camera, or connect the camera to a wall outlet (wall socket) with the AC Adaptor (not supplied) and the USB / A/V / DC IN cable for multi-use terminal (not supplied).
   When importing/exporting images on the “Memory Stick Duo”, insert the “Memory Stick Duo” into the camera.
2 Turn on the computer, then press (Playback) button.
3 Connect the camera to your computer.
   “Connecting…” appears on the screen of the camera.
   When a USB connection is established for the first time, your computer automatically runs a program to recognize the camera. Wait for a while.

Notes
• When you import/export images to your computer using a battery pack with little remaining charge, transferring may fail or image data may become corrupted if the battery pack shuts down too soon.
• is displayed on the screen during the communication session. Do not operate the computer while the indicator is displayed. When the indicator changes to , you can start using the computer again.
Importing images to a computer

1 Make a USB connection between the camera and a computer.
   After making a USB connection, the [Import Media Files] screen of “PMB” appears automatically.
   If the AutoPlay Wizard appears, close it.

2 Import the images.
   To start importing images, click the [Import] button.
   By default, images are imported into a folder created in “Pictures” (in Windows XP/2000, “My Pictures”) that is named with the event name of [Event List].

3 View images on your computer.
   When importing is complete, the “PMB” starts.
   Thumbnails of the imported images are displayed.
   The “Pictures” (in Windows XP/2000, “My Pictures”) folder is set as the default folder in “Viewed folders”.

   Organize images on the computer on a calendar by shooting date to view them. For details on “PMB”, see the “PMB Guide”.

Importing images to a computer without using “PMB”

When the AutoPlay Wizard appears in step 1, click [Open folder to view files] → [OK] → [DCIM] → copy the desired images to the computer.
Exporting images to view on the camera

You can export images in your computer to the camera, and view them on the camera. This section describes the procedure for automatically selecting and exporting images that have not been exported to the internal memory.

You can export the images to “Memory Stick Duo” or even export them manually. For details, see the “PMB Guide”.

1 Make a USB connection between the camera and a computer.
   If the AutoPlay Wizard appears, close it.
2 Double-click (PMB) on the desktop to start up “PMB”.
3 Click on the top of the screen.
   The easy export screen appears.
4 Click [Export].
   Image exporting starts.
   When you play back exported images on this camera, the mark is displayed on the LCD screen.

Notes
- You cannot play back some images depending on the image size.
- No guarantees are made for playing back, on this camera, files containing images which were processed on a computer or images which were shot using other cameras.
- When printing images at a shop, export the images to a “Memory Stick Duo”.

Deleting the USB connection

Perform the procedures from step 1 to 3 below before:
- Disconnecting the cable for multi-use terminal.
- Removing a “Memory Stick Duo”.
- Inserting a “Memory Stick Duo” into the camera.
- Turning off the camera.

1 Double-click the disconnect icon on the tasktray.
2 Click (USB Mass Storage Device) → [Stop].
3 Confirm the device on the confirmation window, then click [OK].
The image files recorded with the camera are grouped as folders on the internal memory or the “Memory Stick Duo”.

A Drive used by “PMB Portable”. This folder appears only when [LUN Settings] is set to [Multi].

B Depending on the Windows settings, this folder may not appear on the screen. Since the data of the album information is inside the “AVF_INFO” folder, the albums will no longer be displayed properly if this data is deleted or edited. Do not delete or edit the data inside the “AVF_INFO” folder.

C Folder containing image data recorded using a camera not equipped with the folder creating function.

D Folder containing image data recorded using the camera. When no new folders are created, only “101MSDCF” folder is displayed.

### Notes
- You cannot record any images to the “100MSDCF” folder. The images in this folder are available only for viewing. This folder is displayed only when “Memory Stick Duo” is inserted into the camera.
- You cannot record/play back any images to the “MISC” folder.
- Image files are named as follows:
  - Still image files: DSC0\ssss\JPG
  - Movie files: MOV0\ssss\MPG
  - Index image files that are recorded when you record movies: MOV0\ssss\THM
  \ssss stands for any number within the range from 0001 to 9999. The numerical portions of the name of a movie file recorded in movie mode and its corresponding index image file are the same.
- For more information about folders, see pages 55 and 99.
- When folders are moved, it may no longer be possible to view their images on the camera.
Uploading images to a media service

This camera has a built-in application “PMB Portable”.
You can use this application to do the following:
• You can easily upload images to a blog or other media service using a computer.
• You can easily filter the images you want to upload by registering them in the camera as Sharemark images (page 104).
• You can upload images from a computer connected to the Internet even when you are away from home or the office.
• You can easily register the media services (such as blogs) you use frequently.
For details on “PMB Portable”, see the “PMB Portable” help.

When using “PMB Portable” for the first time, you must select the language. Follow the procedure below to make the selection. Once the language selection has been made, steps 3 to 5 are unnecessary the next time you use “PMB Portable”.

1 Make a USB connection between the camera and a computer.
When you connect the camera and your computer, AutoPlay Wizard appears.
Click [×] to close the AutoPlay Wizard for any unnecessary drives.
• If the desired AutoPlay Wizard does not appear, click [Computer] (in Windows XP/2000, [My Computer]) → [PM BorT] → [PMB P.exe].

2 Click “PMB Portable” (in Windows XP, [PMB Portable] → [OK]).
The User Agreement screen appears.

3 Read the agreement carefully. If you accept the terms of the agreement, click [I Agree].
The Language Selection screen appears.

4 Select the desired language, then click [OK].
The Region Selection screen appears.

5 Select the appropriate [Area] and [Country/Region], and then click [OK].
“PMB Portable” starts up.

Notes
• Set [LUN Settings] in [Settings] to [Multi].
• Always connect to a network when using “PMB Portable”.
• When uploading images over the Internet, the cache may remain in the computer being used depending on the service provider. This is also true when this camera is used for this purpose.
• When a bug occurs in “PMB Portable” or you delete “PMB Portable” by mistake, you can repair “PMB Portable” using “PMB”. For details, see the “PMB Guide”.

“PMB Portable” makes it possible to download the URLs of a number of websites from the server administered by Sony (the “Sony server”). In order to use “PMB Portable” to enjoy the benefits of the image uploading service or other services (the “services”) provided by these and other websites, you must consent to the following.

- Some websites require registration procedures and/or fees to use their services. In using such services, you must comply with the terms and conditions established by the websites concerned.
- Services may be terminated or changed in accordance with the convenience of the website operators. Sony will not be held responsible for any trouble occurring between the users and third parties or any inconvenience caused to users relating to the utilization of the services inclusive of the termination of or changes to such services.
- To view a website, you will be redirected to it by the Sony server. There may be times when you cannot access the website because of server maintenance or for other reasons.
- If the operation of the Sony server is to be terminated, you will be notified of the termination ahead of time on Sony website, etc.
- The URLs to which you are redirected by the Sony server and other information may be recorded for the purposes of improving Sony future products and services. However, no personal data will be recorded on such occasions.
Using the “Music Transfer” (supplied)

You can change the Music files that are preset at the factory to the desired Music files using “Music Transfer” in the CD-ROM (supplied). You can also delete or add these files whenever you want.

Adding/Changing Music using “Music Transfer”

The music formats you can transfer with “Music Transfer” are listed below:
- MP3 files stored on the hard disk drive of your computer
- Music on CDs
- Preset-music saved on the camera

1. HOME → [View Images 2] → [Music Tool] → OK → [Download Music] → OK
   The message “Connect to PC” appears.

2. Make a USB connection between the camera and your computer.

3. Start “Music Transfer”.

4. Follow the instructions on the screen to add/change Music files.

To restore the music preset at the factory to the camera

① Perform [Format Music] (page 53).
   All Music files return to the preset-music, and [Music] in the [Slideshow] menu is set to [Off].
- You can reset the Music files to the preset ones using [Initialize] (page 59), however, other settings will also be reset.
- For details on using “Music Transfer”, see the on-line help in “Music Transfer”.

Using your Macintosh computer

You can copy images to your Macintosh computer. “PMB” is not compatible with Macintosh computers.
When images is exported to the camera, view them in the Folder View mode (page 51).

Recommended computer environment

The following environment is recommended for a computer connected to the camera.

Recommended environment for copying images
OS (pre-installed): Mac OS 9.1/9.2/ Mac OS X (v10.1 to v10.5)
USB jack: Provided as standard

Recommended environment for using “Music Transfer”
OS (pre-installed): Mac OS X (v10.3 to v10.5)
Memory: 64 MB or more (128 MB or more is recommended)
Hard Disk: Disk space required for installation—approximately 250 MB

Notes
- Operations are not guaranteed for all the recommended computer environments mentioned above.
- If you connect two or more USB devices to a single computer at the same time, some devices, including the camera, may not operate depending on the types of USB devices you are using.
- Operations are not guaranteed when using a USB hub.
- Connecting the camera using a USB interface that is compatible with Hi-Speed USB (USB 2.0 compliant) allows advanced transfer (high speed transfer) as the camera is compatible with Hi-Speed USB (USB 2.0 compliant).
- There are four modes for a USB connection when connecting a computer, [Auto] (default setting), [Mass Storage], [PictBridge] and [PTP/MTP] modes. This section describes the [Auto] and [Mass Storage] as examples. For details on [PictBridge] and [PTP/MTP], see page 62.
- When your computer resumes from the suspend or sleep mode, communication between the camera and your computer may not recover at the same time.

Additional information on this product and answers to frequently asked questions can be found at the Sony Customer Support Website.  
http://www.sony.net/
**Importing and viewing images on a computer**

1. Prepare the camera and a Macintosh computer.
2. Connect the camera to your computer with the cable for multi-use terminal.

3. Copy image files to the Macintosh computer.
   1. Double-click the newly recognized icon → [DCIM] → the folder where the images you want to import are stored.
   2. Drag and drop the image files to the hard disk icon.
      - The image files are copied to the hard disk.
      - For details on the storage location of the images and file names, see page 138.

4. View images on the computer.
   Double-click the hard disk icon → the desired image file in the folder containing the copied files to open that image file.

**Deleting the USB connection**

Drag and drop the drive icon or the icon of the “Memory Stick Duo” to the “Trash” icon beforehand when you perform the procedures listed below, or the camera is disconnected from the computer.
- Disconnecting the cable for multi-use terminal.
- Removing a “Memory Stick Duo”.
- Inserting a “Memory Stick Duo” into the camera.
- Turning off the camera.
You can change the Music files that are preset at the factory to the desired Music files. You can also delete or add these files whenever you want.
The music formats you can transfer with “Music Transfer” are listed below:
• MP3 files stored on the hard disk drive of your computer
• Music on CDs
• Preset-music saved on the camera

To install “Music Transfer”
• Shut down all other application software before you install “Music Transfer”.
• For installation, you need to log on as Administrator.

1 Turn on yourMacintosh computer, and insert the CD-ROM (supplied) into the CD-ROM drive.
2 Double-click  (SONYPICUTIL).
   The installation of the software starts.
4 Add/change Music files.
   Refer to “Adding/Changing Music using “Music Transfer”” on page 141.
Viewing “Cyber-shot Step-up Guide”

“Cyber-shot Step-up Guide” further introduces how to use the camera and optional accessories.

Viewing on Windows

When you install “Cyber-shot Handbook”, “Cyber-shot Step-up Guide” is also installed.

Double-click (Step-up Guide) on the desktop.
To access “Step-up Guide” from the Start menu, click [Start] → [All Programs] (in Windows 2000, [Programs]) → [Sony Picture Utility] → [Step-up Guide].

Viewing on Macintosh

1 Copy the [stepupguide] folder in the [stepupguide] folder to your computer.

2 Select [stepupguide], [language] and then [GB] folder stored in the CD-ROM (supplied), and copy all the files in the [GB] folder to the [img] folder in the [stepupguide] folder that you copied to your computer in step 1. (Overwrite the files in the [img] folder with the files from the [GB] folder.)

3 After copying is complete, double-click “stepupguide.hqx” in the [stepupguide] folder to uncompress it, then double-click the generated file “stepupguide”.
   • If an uncompress tool for HQX file is not installed, install the Stuffit Expander.
Printing still images

You can print still images by the following methods.

Printing directly using a PictBridge compliant printer (page 147)

You can print images by connecting the camera directly to a PictBridge compliant printer.

Printing directly using a “Memory Stick” compliant printer

You can print images with a “Memory Stick” compliant printer. For details, see the operating instructions supplied with the printer.

Printing using a computer

You can import images to a computer using the supplied “PMB” software and print the images. You can insert the date on the image and print it. For details, see the “PMB Guide”.

Printing at a shop (page 149)

You can take a “Memory Stick Duo” containing images shot with the camera to a photo printing service shop. You can make a DPOF (Print order) mark on the images which you want to print out in advance.

Note

- When you print images shot in [16:9] mode, both edges may be cut off.
Printing images directly using a PictBridge compliant printer

Even if you do not have a computer, you can print images shot using the camera by connecting the camera directly to a PictBridge compliant printer.

*PictBridge* “PictBridge” is based on the CIPA standard. (CIPA: Camera & Imaging Products Association)

**Note**
- You cannot print movies.

### Stage 1: Preparing the camera

Prepare the camera for USB connection to the printer, using the cable for multi-use terminal. When [USB Connect] is set to [Auto], the camera will automatically recognize certain printers when connected. Skip Stage 1, if this is the case.

1. Insert the sufficiently charged battery pack into the camera.
2. **HOME** → 📈 (Settings) → [Main Settings] → OK → [USB Connect] → OK → [PictBridge] → OK
   The USB mode is set.

### Stage 2: Connecting the camera to the printer

1. Connect the camera to the printer.

2. Turn on the printer.
   An image and the screen for selecting the images to be printed appear.
   If the 🔄 indicator flashes on the screen of the camera (error notification), check the connected printer.
Stage 3: Printing

1. \[\text{MENU} \rightarrow \text{Print} \rightarrow \text{desired item} \rightarrow \text{OK}\]

   **Printing the currently displayed image**
   In single-image mode, select [This Image] as the desired item.

   **Selecting and printing multiple images**
   Select [Multiple Images] as the desired item.

   **In single-image mode**
   1. Touch ➤/}</ to display the image, then touch the image you want to print.
   2. Repeat step 1.
   3. ➤ ➤ [OK]

   **In index mode**
   1. Touch Δ/∇ to turn the pages, then touch the image you want to print.
   2. Repeat step 1 to print more images.
   3. ➤ [OK]

   **Printing all images in the date range, event group, Favorites or folder**
   In index mode, select [All in Date Range], [All in Event], [All in Favorites] or [All in This Folder] as the desired item, then touch [OK].

2. Touch the desired setting item to make the print settings.

   **[Quantity]**
   Selects the number of copies of the specified image to be printed.
   - The designated number of images may not all fit onto a single sheet depending on the quantity of images.

   **[Layout]**
   Selects the number of images you want to print side by side on a sheet.

   **[Size]**
   Selects the size of the printing sheet.

   **[Date]**
   Selects [Day&Time] or [Date] to insert the date and time on images.
   - When you choose [Date], the date will be inserted in the order you select (page 74). This function may not be provided depending on the printer.

3. Touch [OK].

   The image is printed.
   - Do not disconnect the cable for multi-use terminal while the \(\) (PictBridge Connecting) indicator appears on the screen.
   Make sure the screen has returned to stage 2, and disconnect the cable for multi-use terminal from the camera.
Printing at a shop

You can take a “Memory Stick Duo” containing images shot with the camera to a photo printing service shop. As long as the shop supports photo printing services conforming to the DPOF, you can make a DPOF (Print order) mark on images in advance so that you do not need to reselect them when you print them out at the shop (page 113).

When taking a “Memory Stick Duo” to a shop

- Consult your photo printing service shop as to what types of “Memory Stick Duo” they handle.
- If a “Memory Stick Duo” is not handled by your photo printing service shop, copy the images you want to print out to another medium such as a CD-R and take it to the shop.
- The “Memory Stick Duo” Adaptor (not supplied) may be necessary. Consult your photo printing service shop.
- Before you take image data to a shop, always copy (back up) your data to a disk.
- You cannot set the number of prints.
- When you want to superimpose dates on images, consult your photo printing service shop.

Note

- You cannot print images stored in the internal memory at a print shop directly from the camera. Export the images to a “Memory Stick Duo” using “PMB”, then take the “Memory Stick Duo” to the print shop (page 135).
Troubleshooting

If you experience trouble with the camera, try the following solutions.

1. **Check the items on pages 151 to 160.**
   If a code such as “C/E:□□:□□” appears on the screen, see page 161.

2. **Remove the battery pack, wait for about one minute, re-insert the battery pack, then turn on the power.**

3. **Initialize the settings (page 59).**

4. **Consult your Sony dealer or local authorized Sony service facility.**

On repairing cameras with internal memory or Music files function included, data in the camera may be checked on minimum necessity to verify and improve the malfunction symptoms. Sony will not copy or save any of those data.

Additional information on this product and answers to frequently asked questions can be found at our Customer Support Website.
http://www.sony.net/

Click one of the following items to jump to the page explaining the symptom and cause or the appropriate corrective action.

| Battery pack and power .............. 151 | Internal memory ....................... 158 |
| Shooting still images/movies ...... 151 | Printing ........................................ 158 |
| Viewing images ......................... 154 | PictBridge compliant printer .......... 158 |
| Deleting .................................. 155 | Touch panel .................................. 159 |
| Computers ............................... 155 | Others ......................................... 160 |
| Wireless network ....................... 157 | Warning indicators and messages ........ 161 |
| “Memory Stick Duo” .................... 157 |
Battery pack and power

Cannot insert the battery pack.
- Insert the battery pack correctly to push the battery eject lever.

Cannot turn on the camera.
- After inserting the battery pack into the camera, it may take a few moments for the camera to power up.
- Insert the battery pack correctly.
- The battery pack is discharged. Insert a charged battery pack.
- The battery pack is dead (page 170). Replace it with a new one.
- Use a recommended battery pack.

The power turns off suddenly.
- If you do not operate the camera for about three minutes while the power is on, the camera turns off automatically to prevent wearing down the battery pack. Turn on the camera again.
- The battery pack is dead (page 170). Replace it with a new one.

The remaining charge indicator is incorrect.
- The battery charge is quickly used up in the following cases:
  - When you use the camera in an extremely hot or cold location.
  - When you use the flash and zoom frequently.
  - When you repeatedly turn the power on and off.
  - When [Brightness] of the DISP (screen display) is set to [Bright].
- A discrepancy arose between the remaining charge indicator and the actual remaining battery charge. Fully discharge the battery pack once, then charge it to correct the indication.
- The battery pack is discharged. Insert a charged battery pack.
- The battery pack is dead (page 170). Replace it with a new one.

Cannot charge the battery pack.
- You cannot charge the battery pack using the AC Adaptor (not supplied). Use the battery charger to charge the battery.

Shooting still images/movies

Cannot record images.
- Check the free capacity of the internal memory or “Memory Stick Duo”. If it is full, do one of the following:
  - Delete unnecessary images (page 42).
  - Change the “Memory Stick Duo”.
- You cannot record images while charging the flash.
- When shooting a still image, set the shooting mode other than (Movie).
- Set the shooting mode to (Movie) when shooting movies.
- The image size is set to [640(Fine)] when recording movies. Do one of the following:
  - Set the image size to other than [640(Fine)].
  - Insert a “Memory Stick PRO Duo”.
Smile Shutter function does not work.
- No image is shot if a smiling face is not detected.
- Set the shooting mode to (Auto Adjustment).

The subject is not visible on the screen.
- The camera is set to the playback mode. Press (Playback) button to switch to the shooting mode.

Anti-blur function does not work.
- The anti-blur function does not work when (Anti-blur) appears on the display.
- The anti-blur function may not work properly when shooting night scenes.
- Shoot after pressing the shutter button halfway down; do not press it fully down suddenly.

Recording takes a long time.
- NR slow shutter function is working.
- The Anti Blink function is working.
- When [Anti Blink] is set to [Auto], reset to [Off] (page 91).

The image is out of focus.
- The subject is too close. When shooting, make sure to position the lens farther away from the subject than the shortest shooting distance (approximately 8 cm (3 1/4 inches) (W)/50 cm (19 3/4 inches) (T) from the lens). Or set to (Close focus enabled) mode and shoot about 1 to 20 cm (13/32 to 7 7/8 inches) from the W side distance (page 29).
- (Twilight) mode or (Landscape) mode or (Fireworks) mode is selected in the Scene Selection when shooting still images.
- The Semi manual function is selected. Select the auto focus mode (page 31).

Zoom does not work.
- You cannot use the Optical zoom in (Close focus enabled) mode.
- You cannot use the Smart zoom depending on the image size (page 71).
- You cannot use the Digital Zoom when:
  - Shooting movies.
  - The Smile Shutter is working.

The flash does not work.
- The flash is set to Flash Off (Flash Off) (page 30).
- You cannot use the flash when:
  - [REC Mode] is set to [Burst] or Exposure Bracket (page 84).
  - (High Sensitivity) mode or (Twilight) mode or (Fireworks) mode is selected in the Scene Selection (page 22).
  - Shooting movies.
- Set the flash to Flash On (Flash On) (page 30) in (Close focus enabled) mode or when the Scene Selection mode is set to (Landscape), (Gourmet), (Beach), (Snow) or (Hi-Speed Shutter).

Fuzzy white circular spots appear in images shot using the flash.
- Particles (dust, pollen, etc.) in the air reflected the flash light and appeared in the image. This is not a malfunction (page 30).
The close-up shoot function (Macro/Close focus enabled) does not work.
- (Landscape) mode or (Twilight) mode or (Fireworks) mode is selected in the Scene Selection (page 22).
- When (Close focus enabled) mode is selected, the shooting distance is approximately 1 to 20 cm (13/32 to 7 7/8 inches).

Macro shooting cannot be turned off.
- There is no function for forcibly turning off macro shooting. In (Auto) mode, telephoto shooting is possible even in the macro shooting condition.

The date and time are not displayed on the LCD screen.
- While shooting, the date and time are not displayed. They are displayed only during playback.

Cannot insert dates on images.
- This camera does not have a feature for superimposing dates on images (page 158). By using “PMB”, you can print or save images with the date (page 134).

The F value and shutter speed flash when you press and hold the shutter button halfway down.
- The exposure is incorrect. Correct the exposure (pages 35, 85).

The LCD screen is too dark or too bright.
- Adjust the brightness of the backlight (page 17).

The image is too dark.
- You are shooting a subject with a light source behind the subject. Select the metering mode (pages 33, 86) or adjust the exposure (pages 35, 85).

The image is too bright.
- Adjust the exposure (pages 35, 85).

The image colors are not correct.
- Set [Color Mode] to [Normal] (page 94).
- Adjust the White Balance (page 88).

Vertical streaks appear when you are shooting a very bright subject.
- The smear phenomenon is occurring and white, black, red, purple, or other streaks appear on the image. This phenomenon is not a malfunction.

Noise appears in the image when you view the screen in a dark place.
- The camera is attempting to increase the visibility of the screen by temporarily brightening the image under conditions of low illumination. There is no effect on the recorded image.
The eyes of the subject come out red.
- Shoot the subject at a distance closer than the flash range using the flash.
- Light the room and shoot the subject.
- Retouch the image using [Red Eye Correction] (page 106).

Dots appear and remain on the screen.
- This is not a malfunction. These dots are not recorded (page 3).

Cannot shoot images in succession.
- The internal memory or “Memory Stick Duo” is full. Delete unnecessary images (page 42).
- The battery level is low. Insert charged battery pack.

The same image is shot several times.
- [REC Mode] is set to [Burst] (page 84). Or, [Scene Recognition] is set to [Advanced] (page 78).

Viewing images

Cannot play back images.
- Press ➤ (Playback) button.
- The folder/file name has been changed on your computer.
- No guarantees are made for playing back, on this camera, files containing images which were processed on a computer or images which were shot using other cameras.
- The camera is in USB mode. Delete the USB connection (page 137).
- You may not be able to play back some images stored on the “Memory Stick Duo” shot using other cameras. Play such images in Folder View (page 51).
- This is caused by copying images on your computer to the “Memory Stick Duo” without using the “PMB”. Play such images in Folder View (page 51).

The date and time are not displayed.
- [Display Setup] is set to [Simple] or [Image Only]. Touch DISP to set [Display Setup] to [Normal] (page 16).

The image appears rough right after playback starts.
- This may happen due to image processing. This is not a malfunction.

Left and right sides of the screen are shown in black.
- [Auto Orientation] is set to [On] (page 72).

The buttons and icons no longer appear.
- If you touch the top right of the screen during shooting, the buttons and icons will momentarily disappear. The buttons and icons will reappear when you take your finger off the screen.
- [Display Setup] is set to [Image Only]. Touch DISP to set [Display Setup] to [Normal] or [Simple] (page 16).
- Touch the center of the screen during playback to display DISP, then select [Normal] or [Simple].
Cannot hear music during slideshow.
- Transfer music files to the camera with “Music Transfer” (page 141).
- Confirm that the volume setting and slideshow setting are correct (pages 39, 116).

The image does not appear on the TV.
- Check [Video Out] to see if the video output signal of the camera is set to the color system of your TV (page 65).
- Check whether the connection is correct (page 128).
- If the USB connector of the cable for multi-use terminal is connected to another device, disconnect it (page 137).
- You are trying to play back movies during HD(1080i) output. Movies cannot be viewed at high-definition image quality. Set [COMPONENT] to [SD] (page 64).

Deleting

Cannot delete an image.
- Cancel the protection (page 111).

Computers

Computer OS compatibility with camera is unknown.
- Check “Recommended computer environment” on page 132 for Windows, and page 142 for Macintosh.

“Memory Stick PRO Duo” is not recognized by a computer with a “Memory Stick” slot.
- Check that the computer and the Memory Stick Reader/Writer support “Memory Stick PRO Duo”. Users of computers and Memory Stick Readers/Writes made by manufacturers other than Sony should contact those manufacturers.
- If “Memory Stick PRO Duo” is not supported, connect the camera to the computer (pages 135 and 143). The computer recognizes the “Memory Stick PRO Duo”.

Your computer does not recognize the camera.
- Turn on the camera.
- When the battery level is low, insert the charged battery pack or use the AC adaptor (not supplied) (page 135).
- Use the cable for multi-use terminal (supplied).
- Disconnect the cable for multi-use terminal from both the computer and the camera, and connect it again firmly.
- Disconnect all equipment other than the camera, the keyboard and the mouse from the USB connectors of your computer.
- Connect the camera directly to your computer without passing through a USB hub or other device (page 135).
Cannot import images.

- Connect the camera and your computer correctly making a USB connection (page 135).
- Follow the designated import procedure for your OS (pages 136 and 143).
- When you shoot images with a “Memory Stick Duo” formatted by a computer, you may not be able to import the images to a computer. Shoot using a “Memory Stick Duo” formatted by the camera (page 54).

After making a USB connection, “PMB” does not start automatically.

- Make the USB connection after the computer is turned on (page 135).

After making a USB connection, “PMB Portable” does not start.

- Set [LUN Settings] to [Multi] (page 63).
- Connect the computer to the network.
- Repair “PMB Portable” using “PMB”. For details, see the “PMB Guide”.

Cannot play back images on your computer.

- If you are using “PMB”, refer to “PMB Guide” (page 134).
- Consult the computer or software manufacturer.

You do not know how to use “PMB”.

- See the “PMB Guide” (page 134).

The image and sound are interrupted by noise when you view a movie on a computer.

- You are playing back the movie directly from the internal memory or the “Memory Stick Duo”. Import the movie to the hard disk of your computer, then play back the movie from the hard disk (page 135).

Cannot print an image.

- Refer to the operation manual of the printer.

Images once exported to a computer cannot be viewed on the camera.

- Export them to a folder recognized by the camera, such as “101MSDCF” (page 138).
- Follow the correct procedures (page 137).
- When using software other than “PMB”, the information may not be updated correctly, so images may turn blue or otherwise not be displayed correctly. This is not a malfunction.
- When blue images appear, view them in the Folder View mode or delete them with the camera.
- Check whether you exported the image to the internal memory or a “Memory Stick Duo”, and play back the image using the recording media to which it was exported.
Wireless network

Cannot establish a connection with the Wireless LAN access point.

- Check to make sure the power of the Wireless LAN access point is on.
- The communication range may be shortened by the surrounding conditions, such as various obstacles, radio wave traffic, and the wall material between this camera and the Wireless LAN access point. Change the location of the camera or move the camera closer to the access point.
- Check whether an encryption key (WEP/WPA) or other special settings (Fixed IP address, proxy settings, etc.) are needed to connect to the access point.
- When the access point is set so that the SSID is hidden, the SSID may not be displayed on the network list. Check the SSID of the access point with an administrator and make settings manually. Or cancel the setting on the access point.
- You may be unable to use the internet at public Wireless LAN access points unless you use the Web or another method to enter your login ID, password, or other identifying information. Check with the wireless network service that you are connecting to.
- Microwave ovens or Bluetooth-enabled devices use the 2.4 GHz wavelength and could hinder the communication. If such devices are in the vicinity, move the camera away from those devices or shut those devices down.

Cannot enter the encryption key.

- For details on the verification method used for the encryption key (WEP key or WPA key), see the operation manual for the access point or the information listed on the bottom panel of the device.
- The number of characters and numbers that can be input differs depending on the encryption type (page 120).

The MAC address of this camera is unknown.

- To check the MAC address, enter an invalid SSID and test the connection to force a connection failure. The MAC address of this camera will be displayed after the connection test.

It takes too much time to transfer an image.

- The communication range may be shortened by the surrounding conditions, such as various obstacles, radio wave traffic, and the wall material between the devices or between this camera and the Wireless LAN access point. Change the location of the devices, put the devices closer together, or move the camera closer to the access point.
- You may be getting a crossed connection with another Wireless LAN access point. Set the wireless channel at the Wireless LAN access point. For further information, refer to the operating manual of the Wireless LAN access point.
- Microwave ovens or Bluetooth-enabled devices use the 2.4 GHz wavelength and could hinder the communication. If such devices are in the vicinity, move the camera away from those devices or shut those devices down.

Cannot connect to a hotspot (public Wireless LAN access point) service.

- Check with the hotspot service provider that you have contracted with.

“Memory Stick Duo”

Cannot insert a “Memory Stick Duo”.

- Insert it in the correct direction.

You have formatted a “Memory Stick Duo” by mistake.

- All the data on the “Memory Stick Duo” is deleted by formatting. You cannot restore it.
Internal memory

Cannot playback or record images using the internal memory.
• There is a “Memory Stick Duo” inserted in the camera. Remove it.

Cannot copy the data stored in the internal memory to a “Memory Stick Duo”.
• You cannot copy image data in the internal memory to a “Memory Stick Duo”. Import images to the computer, and then export them to a “Memory Stick Duo” (pages 136, 137).

Cannot copy the data on the “Memory Stick Duo” to the internal memory.
• You cannot copy images stored in a “Memory Stick Duo” to the internal memory. Export images to a “Memory Stick Duo” using the “PMB” (page 137).

Printing

See “PictBridge compliant printer” together with the following items.

Images are printed with both edges cut off.
• Depending on your printer, all the edges of the image may be cut off. Especially when you print an image shot with the image size set to [16:9], the lateral end of the image may be cut off.
• When printing images using your printer, cancel the trimming or borderless settings. Consult the printer manufacturer as to whether the printer provides these functions or not.
• When having images printed at a digital print shop, ask the shop whether they can print the images without cutting off both edges.

Cannot print images with the date.
• Using “PMB”, you can print images with date (page 134).
• The camera does not have a feature for superimposing dates on images. However, because the images shot with the camera include information on the recording date, you can print images with the date superimposed if the printer or the software can recognize Exif information. For compatibility with Exif information, consult the manufacturer of the printer or the software.
• If you use a photo printing service, ask them to superimpose the dates on images.

PictBridge compliant printer

A connection cannot be established.
• The camera cannot be connected directly to a printer that is not compliant with the PictBridge standard. Consult the printer manufacturer as to whether the printer is compliant with PictBridge or not.
• Check that the printer is turned on and can be connected to the camera.
• Set [USB Connect] to [PictBridge] (page 62).
• Disconnect and connect the cable for multi-use terminal again. If an error message is indicated on the printer, refer to the operating instructions supplied with the printer.
Cannot print images.
- Check that the camera and the printer are properly connected using the cable for multi-use terminal.
- Turn on the printer. For details, refer to the operating instructions supplied with the printer.
- If you select [Exit] during printing, images may not be printed. Disconnect and connect the cable for multi-use terminal again. If you still cannot print your images, disconnect the cable for multi-use terminal, turn the printer off and then on, then connect the cable for multi-use terminal again.
- Movies cannot be printed.
- Images shot using other cameras, or images modified with a computer may not be printed.

Printing is canceled.
- Confirm that you have disconnected the cable for multi-use terminal before the \(\text{Connecting} \) (PictBridge Connecting) mark disappears.

Cannot insert the date or print images in the index mode.
- The printer does not provide these functions. Consult the printer manufacturer as to whether the printer provides these functions or not.
- The date may not be inserted in the index mode depending on the printer. Consult the printer manufacturer.

“---- -- --” is printed on the date-inserted part of the image.
- The image does not have the recording data so the date cannot be inserted. Set [Date] to [Off] and print the image again (page 148).

Cannot select the print size.
- Consult the printer manufacturer as to whether the printer can provide the desired size.

Cannot print the image at the size selected.
- When you use paper of a different size after connecting the printer to the camera, disconnect and then reconnect the cable for multi-use terminal.
- The print setting of the camera differs from that of the printer. Change the setting of either the camera (page 148) or the printer.

Cannot operate the camera after canceling printing.
- Wait for a while as the printer is carrying out the cancellation. It may take some time depending on the printer.

**Touch panel**

Cannot operate the touch panel buttons correctly or fully.
- Perform [Calibration] (page 60).

The paint pen operation reacts at inappropriate points.
- Perform [Calibration] (page 60).
Others

Cannot reset the file-number.
- If you replace a recording medium, you cannot initialize file numbers with the camera. To initialize file numbers, format the “Memory Stick Duo” or the internal memory (page 54), and then initialize the settings (page 59). However, the data on the “Memory Stick Duo” or the internal memory will be deleted and all settings, including date, will be initialized.

The lens gets fogged.
- Moisture condensation has occurred. Turn off the camera and leave it for about an hour before using it.

The camera becomes warm when you use it for a long time.
- This is not a malfunction.

The Clock Set screen appears when you turn on the camera.
- Set the date and time again (page 74).
- The internal rechargeable backup battery has discharged. Insert a charged battery, and set aside for 24 hours or more with the power left off.

You want to change the date or time.
- Set the date and time again (page 74).

You cannot release the password lock.
- Follow the procedure for when you forget the password, and release the password (page 67).
Warning indicators and messages

Self-diagnosis display

If a code starting with a letter of the alphabet appears, the self-diagnosis function on the camera is working. The last two digits (indicated by □□) will differ depending on the state of the camera.
If you cannot solve the problem even after trying the following corrective actions a few times, the camera may need repair.
Contact your Sony dealer or local authorized Sony service facility.

C:32:□□
• There is trouble with the camera’s hardware. Turn the power off and on again.

C:13:□□
• The camera cannot read or write data on the “Memory Stick Duo”. Try turning off and on the camera again, or taking out and inserting the “Memory Stick Duo” several times.
• The internal memory has experienced a format error, or an unformatted “Memory Stick Duo” is inserted. Format the internal memory or the “Memory Stick Duo” (page 54).
• The inserted “Memory Stick Duo” cannot be used with the camera, or the data is damaged. Insert a new “Memory Stick Duo”.

E:61:□□
E:62:□□
E:91:□□
• A camera malfunction has occurred. Initialize the camera (page 59), then turn the power on again.

Messages

If the following messages appear, follow the instructions.

 собой
• The battery level is low. Charge the battery pack immediately. Depending on the conditions of use or the type of battery pack, the indicator may flash even though there are still 5 to 10 minutes of remaining battery time left.

For use with compatible battery only
• The battery inserted is not an NP-BD1 (supplied)/NP-FD1 (not supplied) battery pack.

System error
• Turn the power off and then on again.

Internal memory error
• Turn the power off and then on again.
Reinsert the Memory Stick
- Insert the “Memory Stick Duo” correctly.
- The inserted “Memory Stick Duo” cannot be used in the camera (page 168).
- The “Memory Stick Duo” is damaged.
- The terminal section of the “Memory Stick Duo” is dirty.

Memory Stick type error
- The inserted “Memory Stick Duo” cannot be used in the camera (page 168).

Cannot access Memory Stick
Access denied
- You are using the “Memory Stick Duo” with the access controlled.

Error formatting internal memory
Error formatting Memory Stick
- Format the media again (page 54).

Memory Stick locked
- You are using the “Memory Stick Duo” with the write-protect switch, and the switch is set to the LOCK position. Set the switch to the recording position.

No memory space on internal memory
No memory space on Memory Stick
- Delete unnecessary images or files (page 42).

Read only memory
- The camera cannot record or delete images on this “Memory Stick Duo”.

No images
- No images that can be played back have been recorded in the internal memory.
- No images that can be played back have been recorded in this folder of the “Memory Stick Duo”.
- When images recorded with other cameras cannot be played back on this camera, view the images in Folder View mode (page 51).

No still images
- The selected folder does not contain a file that can be played back in a slideshow.
- The selected folder does not contain a file that can be used as Scrapbook images.
- There are no images that can be filtered by faces.

Folder error
- A folder with the same first three digit number already exists on the “Memory Stick Duo” (for example: 123MSDCF and 123ABCDE). Select another folder, or create a new folder (pages 55, 56).

Cannot create more folders
- The folder with a name beginning with “999” exists on the “Memory Stick Duo”. You cannot create any folders if this is the case.
File error
- An error occurred while the image was playing back. No guarantees are made for playing back, on this camera, files containing images which were processed on a computer or images which were shot using other cameras.

Read only folder
- You have selected a folder that cannot be set as a recording folder on the camera. Select another folder (page 56).

File protected
- Release the protection (page 111).

Image size over limit
- You are playing back an image with size that cannot be played back on the camera.

Invalid operation
- You have touched the panel when using the digital zoom or Close focus enabled mode. While using these modes, you cannot focus by touching the screen.

Unable to detect face for retouch
- You may not be able to retouch the image depending on the image.

(Vibration warning indicator)
- Camera shake may occur due to insufficient light. Use the flash, turn on the anti-blur function, or mount the camera on a tripod to secure the camera.

640(Fine) is not available
- [640(Fine)] size movies can be recorded only using a “Memory Stick PRO Duo”. Insert a “Memory Stick PRO Duo” or set the image size to a size other than [640(Fine)].

Zoom disabled
- [Digital Zoom] is set to [Off] when you are shooting in (Close focus enabled) mode. Or, you are trying to use [Smart] in [Digital Zoom] when the image size is set to [10M], [3:2(8M)] or [16:9(7M)] (page 71).

Maximum number of images already selected
- Up to 100 files can be selected when using [Multiple Images].
- Up to 999 files can be selected when using [All in Date Range], [All in Event], [All in Favorites] or [All in This Folder].
- Up to 999 files can be registered as Favorites or Sharemark images, and you can add DPOF (Print order) marks to up to 999 files. Cancel the selection.

Low battery power
- When copying a image recorded in the internal memory to the “Memory Stick Duo”, use a fully charged battery.
Printer busy
Paper error
No paper
Ink error
Low ink
No ink
  • Check the printer.

Printer error
  • Check the printer.
  • Check if the image you want to print is corrupted.

⚠️ The data transmission to the printer may not be completed yet. Do not disconnect the cable for multi-use terminal.

Processing...
  • The printer is canceling the current print job. You cannot print until it is finished. This may take time, depending on the printer.

Error Playing Music
  • Delete the Music file, or replace it with a normal Music file.
  • Execute [Format Music], then download a new Music files.

Error Formatting Music
  • Execute [Format Music].

Operation cannot be executed during HD(1080i) output
  • Some functions are restricted while the camera is connected to a High Definition TV.

Operation cannot be executed during TV output
  • Some functions are restricted while the camera is connected to a TV.

Operation cannot be executed for movie files
  • You have selected a function that is not available for movies.

Operation cannot be executed in unsupported files
  • Processing and other editing functions of the camera cannot be performed on image files that have been processed using a computer or images that were recorded with other cameras.

Operation cannot be executed when using a PictBridge connection
  • Some functions are restricted while the camera is connected to a PictBridge compliant printer.

Recovering image management file…
  • The camera restores the date information etc. in cases where images have been deleted on a PC, etc.
• The number of images exceeds that for which date or event management by the camera is possible. Delete images from the Date View or Event View.

Image management file error
• Import all of the images to the computer with “PMB”, and format the “Memory Stick Duo” or the internal memory (page 54).
  When you cannot import all of the images to the computer with “PMB”, import all of the images to the computer without using “PMB” (page 136).
  To view the images again with the camera, export the imported images to the camera with “PMB”.

Access Point not found
• Check the Access Point settings.
• Check the settings on the Access Point side.
• Check that you are in the active area of the Access Point.

Cannot connect
• Check the Access Point settings.
• Check that you are in the active area of the Access Point.
• Check the settings of the DLNA device you are attempting to connect to.

Cannot connect to network
Please select again later
• Currently disconnecting from the Access Point.

Enter an encryption key
5 to 26 characters in length
Enter an encryption key
8 to 64 characters in length
• You have entered an encryption key that exceeds the correct number of characters or digits (page 120).

Cannot use PPPoE with image sharing
Cannot use PPPoE with other device
• Cancel PPPoE settings of the Access Point.

Connectable device not found
Previously connected device not found
• Check that the connected device and Access Point are connected.
• Check that the connected device is ready.

Unknown error occurred
• An error occurred during processing. Operate the camera again.

Invalid response
• Check the state of the connected device.
<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot connect to network</td>
<td>• Check the state of the Access Point.</td>
</tr>
<tr>
<td></td>
<td>• Check that you are in the active area of the Access Point.</td>
</tr>
<tr>
<td>Selected device settings incompatible</td>
<td>• Check the state of the connected device.</td>
</tr>
<tr>
<td>Not enough available system memory</td>
<td>• There is not enough memory. Terminate the network connection.</td>
</tr>
<tr>
<td>Slideshow not supported</td>
<td>• To send images connect to a device that supports Slideshow.</td>
</tr>
<tr>
<td>Error occurred while sending data</td>
<td>• Check the state of the connected device.</td>
</tr>
<tr>
<td>Cannot upload this movie file</td>
<td>• File size too large. Only files up to 100MB can be uploaded.</td>
</tr>
<tr>
<td>Secure and unsecure pages coexist</td>
<td>• Cannot open the browser on this camera because the retrieved content includes both HTTP and HTTPS.</td>
</tr>
<tr>
<td>Available memory full</td>
<td>• Not enough memory. Close unnecessary tabs or terminate the browser.</td>
</tr>
<tr>
<td>Cannot display images correctly</td>
<td></td>
</tr>
</tbody>
</table>
Using the camera abroad — Power sources

You can use the camera, the battery charger (supplied), and the AC-LS5K AC Adaptor (not supplied) in any country or region where the power supply is within 100 V to 240 V AC, 50/60 Hz.

**Note**
- Do not use an electronic transformer (travel converter), as this may cause a malfunction.
### On the “Memory Stick Duo”

A “Memory Stick Duo” is a compact, portable IC recording medium. The types of “Memory Stick Duo” that can be used with the camera are listed in the table below. However, proper operation cannot be guaranteed for all “Memory Stick Duo” functions.

<table>
<thead>
<tr>
<th>“Memory Stick” type</th>
<th>Recording/Playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Memory Stick Duo” (without MagicGate)</td>
<td>○*1</td>
</tr>
<tr>
<td>“Memory Stick Duo” (with MagicGate)</td>
<td>○<em>2</em>1</td>
</tr>
<tr>
<td>“MagicGate Memory Stick Duo”</td>
<td>○<em>1</em>2</td>
</tr>
<tr>
<td>“Memory Stick PRO Duo”</td>
<td>○<em>2</em>3</td>
</tr>
<tr>
<td>“Memory Stick PRO-HG Duo”</td>
<td>○<em>2</em>3*4</td>
</tr>
</tbody>
</table>

*1 High-speed data transfer using a parallel interface is not supported.
*2 “Memory Stick Duo”, “MagicGate Memory Stick Duo”, “Memory Stick PRO Duo” and “Memory Stick PRO-HG Duo” are equipped with MagicGate functions. MagicGate is copyright protection technology that uses encryption technology. Data recording/playback that requires MagicGate functions cannot be performed with the camera.
*3 [640(Fine)] size movies can be recorded.
*4 This camera does not support 8-bit parallel data transfer. It performs the same 4-bit parallel data transfer as the “Memory Stick PRO Duo”.

- This product is compatible with “Memory Stick Micro” (“M2”). “M2” is an abbreviation for “Memory Stick Micro”.
- A “Memory Stick Duo” formatted with a computer is not guaranteed to operate with the camera.
- Data read/write speeds differ depending on the combination of the “Memory Stick Duo” and the equipment used.
- Do not remove the “Memory Stick Duo” while reading or writing data.
- Data may be corrupted in the following cases:
  - When the “Memory Stick Duo” is removed or the camera is turned off during a read or write operation
  - When the “Memory Stick Duo” is used in locations subject to static electricity or electrical noise
- We recommend backing up important data.
- Do not press down hard when you write down on the memo area.
- Do not attach a label on the “Memory Stick Duo” itself nor on a “Memory Stick Duo” Adaptor.
- When you carry or store the “Memory Stick Duo”, put it in the case supplied with it.
- Do not touch the terminal section of the “Memory Stick Duo” with your hand or a metal object.
- Do not strike, bend or drop the “Memory Stick Duo”.
- Do not disassemble or modify the “Memory Stick Duo”.
- Do not expose the “Memory Stick Duo” to water.
- Do not leave the “Memory Stick Duo” within the reach of small children. They might accidentally swallow it.
- Do not insert anything other than a “Memory Stick Duo” into the “Memory Stick Duo” slot. Doing so will cause a malfunction.
- Do not use or store the “Memory Stick Duo” under the following conditions:
  - High temperature locations such as the hot interior of a car parked in direct sunlight
  - Locations exposed to direct sunlight
  - Humid locations or locations with corrosive substances present

---

*Continued*
Notes on using the “Memory Stick Duo” Adaptor (not supplied)

- To use a “Memory Stick Duo” with a “Memory Stick” compliant device, be sure to insert the “Memory Stick Duo” into a “Memory Stick Duo” Adaptor. If you insert a “Memory Stick Duo” into a “Memory Stick” compliant device without a “Memory Stick Duo” Adaptor, you might not be able to remove it from the device.
- When inserting a “Memory Stick Duo” into a “Memory Stick Duo” Adaptor, make sure the “Memory Stick Duo” is inserted facing in the correct direction, then insert it all the way in. Incorrect insertion may result in a malfunction.
- When using a “Memory Stick Duo” inserted into a “Memory Stick Duo” Adaptor with a “Memory Stick” compliant device, make sure that the “Memory Stick Duo” Adaptor is inserted facing the correct direction. Note that improper use may damage the equipment.
- Do not insert a “Memory Stick Duo” Adaptor into a “Memory Stick” compliant device without a “Memory Stick Duo” attached. Doing so may result in malfunction of the unit.

Notes on using “Memory Stick PRO Duo” (not supplied)

“Memory Stick PRO Duo” with a capacity up to 16 GB have been confirmed to operate properly with the camera.

Notes on using “Memory Stick Micro” (not supplied)

- To use a “Memory Stick Micro” with the camera, be sure to insert the “Memory Stick Micro” into an “M2” Adaptor as large as of Duo size. If you insert a “Memory Stick Micro” into the camera without an “M2” Adaptor as large as of Duo size, you might not be able to remove it from the camera.
- Do not leave the “Memory Stick Micro” within the reach of small children. They might accidentally swallow it.
On the battery pack

On charging the battery pack

• We recommend charging the battery pack in an ambient temperature of between 10°C to 30°C (50°F to 86°F). The battery pack may not be fully charged in temperatures outside this range.

Effective use of the battery pack

• Battery performance decreases in low temperature surroundings. So in cold places, the operational time of the battery pack is shorter. We recommend the following to ensure longer battery pack use:
  – Put the battery pack in a pocket close to your body to warm it up, and insert it in the camera immediately before you start shooting.
  – The battery pack will run out quickly if you use the flash or zoom frequently.
  – We recommend having spare battery packs handy for two or three times the expected shooting time, and making trial shots before taking the actual shots.
  – Do not expose the battery pack to water. The battery pack is not water-resistant.
  – Do not leave the battery pack in extremely hot places, such as in a car or under direct sunlight.

How to store the battery pack

• Fully discharge the battery pack before storing and store it in a cool, dry place. To maintain the battery pack’s function, fully charge the battery pack and then fully discharge it on the camera at least once a year while storing.
  – To use the battery pack up, leave the camera in slideshow (page 39) playback mode until the power goes off.
  – To prevent staining the terminal, short-circuiting, etc., be sure to use a supplied battery case when carrying and storing.

On battery life

• The battery life is limited. Battery capacity decreases over time and through repeated use. If decreased usage time between charges becomes significant, it is probably time to replace it with a new one.
  – The battery life varies according to how it is stored and the operating conditions and environment in which each battery pack is used.

Compatible battery pack

• The NP-BD1 (supplied) can be used only in D type compatible Cyber-shot models. It cannot be used in Cyber-shot models compatible with the T type and other battery types.
  – If you use the NP-FD1 battery pack (not supplied), the minutes also appear after the battery remaining indicator (  60 Min).
On the battery charger

- Only D-type, T-type, R-type and E-type battery packs (and no others) can be charged in the battery charger (supplied). Batteries other than the specified kind may leak, overheat, or explode if you attempt to charge them, posing a risk of injury from electrocution and burns.
- The batteries that are compatible with this camera are D type batteries. The supplied battery is NP-BD1 (D type).
- Remove the charged battery pack from the battery charger. If you leave the charged battery pack in the charger, battery life may be shortened.
- When the CHARGE lamp flashes, remove the battery pack being charged, and then inserting the same battery pack into the battery charger again until it clicks. When the CHARGE lamp flashes again, this may indicate a battery error or that a battery pack other than the specified type has been inserted. Check that the battery pack is the specified type. If the battery pack is the specified type, remove the battery pack, replace it with a new one or another one and check if the battery charger operates correctly. If the battery charger operates correctly, a battery error may have occurred.
On Cyber-shot Station

Using the Cyber-shot Station (not supplied) enables faster charging than the supplied battery charger, easy connection to a TV, and lets you enjoy even HD picture quality.

The CSS-HD2 Cyber-shot Station (not supplied) is compliant to the camera. In order to mount the camera on the CSS-HD2, the supplied station plate H must be attached to the camera.

For details, refer to the operating instructions supplied with the Cyber-shot Station.

1 Set the station plate as illustrated below.
   You will hear a click when the station plate is correctly mounted.

2 Mount the camera on the Cyber-shot Station.
Operating the Cyber-shot Station with the remote

When the remote supplied with the CSS-HD2 is used with this camera, the following operations are available. For details on buttons not described here, refer to the instruction manual supplied with the Cyber-shot Station.

You can operate only the POWER button while using network functions.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>(Slideshow) Displays the setting screen of the slideshow (page 39). Although the screen differs when button on the camera is touched, setting items do not change.</td>
</tr>
<tr>
<td>2</td>
<td>MENU This button is invalid.</td>
</tr>
<tr>
<td>3</td>
<td>Displays the previous/next image (in single-image mode)/Moves the cursor (in index mode). Switches to the single-image mode (in index mode).</td>
</tr>
<tr>
<td>4</td>
<td>Changes the screen display (in single-image mode)/Moves the cursor (in index mode).</td>
</tr>
<tr>
<td>5</td>
<td>HOME This button is invalid.</td>
</tr>
<tr>
<td>6</td>
<td>Moves the cursor (in index mode).</td>
</tr>
</tbody>
</table>

Note

- You can operate only the POWER button while using network functions.
### Index

#### A
- Access Point ........................................... 117, 118
- Add / Remove Favorites ............................. 102
- Add / Remove Sharemark ......................... 104
- Adjusting EV ......................................... 35, 85
- AF Illuminator ........................................ 68
- AF Mode .............................................. 70
- AF range finder frame ............................ 31
- Anti Blink ............................................. 79, 91
- Aperture .............................................. 36
- Auto Adjustment .................................. 20
- Auto Orientation .................................. 72
- Auto Review ........................................ 73

#### B
- B & W .................................................. 94
- Battery charger ..................................... 171
- Battery pack ...................................... 170
- Be Viewed .......................................... 124
- Beach ................................................ 21
- Beep .................................................. 57
- Brightness ........................................ 17
- BRK .................................................. 84
- Burst ................................................ 84

#### C
- Cable for multi-use terminal ....................... 128, 135, 143, 147
- Calibration ........................................ 60
- CD-ROM .......................................... 133
- Center AF ......................................... 31
- Center-weighted metering ....................... 33, 86
- Change REC.Folder ............................... 56
- Changing the display ........................... 16
- Clock Settings ................................... 74
- Close focus ...................................... 29
- Cloudy ........................................... 88
- Color Mode ...................................... 94
- Communication .................................. 12
- COMPONENT ..................................... 64

- Computer .......................................... 131
- Exporting images ................................ 137
- Importing images ............................... 136, 143
- Macintosh ........................................ 142
- Recommended computer environment ...... 132, 142
- Software .......................................... 133
- Windows ......................................... 131

#### D
- Date .................................................. 74, 148
- Date List ........................................... 97
- Date View ......................................... 48
- Daylight .......................................... 88
- Delete .............................................. 42, 110
- Demo mode ....................................... 61
- Digital Zoom ..................................... 71
- DirectX ........................................... 133
- DISP ............................................... 16
- DLNA ............................................... 124, 125
- Download Music .................................. 52
- DPOF ............................................... 113
- DRO .................................................. 93
- Dynamic Range Optimizer ................. 93

#### E
- Easy Shooting ...................................... 24
- Electronic transformer ......................... 167
- EV ................................................... 35, 85
- Event List ........................................ 98
- Event View ....................................... 49
- Exposure ......................................... 36, 85
- Exposure Bracket ............................... 84
- Extension ........................................ 138
<table>
<thead>
<tr>
<th>Operation</th>
<th>HOME/MENU</th>
<th>Table of Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC</td>
<td>131</td>
<td></td>
</tr>
<tr>
<td>PictBridge</td>
<td>62, 147</td>
<td></td>
</tr>
<tr>
<td>Pixel</td>
<td>77</td>
<td></td>
</tr>
<tr>
<td>Playback</td>
<td>37, 45</td>
<td></td>
</tr>
<tr>
<td>Playback zoom</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>PMB</td>
<td>134</td>
<td></td>
</tr>
<tr>
<td>PMB Portable</td>
<td>139</td>
<td></td>
</tr>
<tr>
<td>Precision digital zoom</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>113, 146</td>
<td></td>
</tr>
<tr>
<td>Print order mark</td>
<td>149</td>
<td></td>
</tr>
<tr>
<td>Printing at a shop</td>
<td>149</td>
<td></td>
</tr>
<tr>
<td>Program Auto</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Protect</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>PTP</td>
<td>62</td>
<td></td>
</tr>
<tr>
<td>R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Radial Blur</td>
<td>107</td>
<td></td>
</tr>
<tr>
<td>REC Mode</td>
<td>13, 84</td>
<td></td>
</tr>
<tr>
<td>Red Eye Correction</td>
<td>106</td>
<td></td>
</tr>
<tr>
<td>Red Eye Reduction</td>
<td>92</td>
<td></td>
</tr>
<tr>
<td>Retouch</td>
<td>106</td>
<td></td>
</tr>
<tr>
<td>Retro</td>
<td>107</td>
<td></td>
</tr>
<tr>
<td>Rotate</td>
<td>115</td>
<td></td>
</tr>
<tr>
<td>S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scene Recognition</td>
<td>78</td>
<td></td>
</tr>
<tr>
<td>Scene Selection</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td>Scrapbook</td>
<td>46</td>
<td></td>
</tr>
<tr>
<td>Screen</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>SD</td>
<td>64</td>
<td></td>
</tr>
<tr>
<td>Select Folder</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>Self-diagnosis display</td>
<td>161</td>
<td></td>
</tr>
<tr>
<td>Self-Timer</td>
<td>28</td>
<td></td>
</tr>
<tr>
<td>Semi manual</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>Send and View</td>
<td>125</td>
<td></td>
</tr>
<tr>
<td>Sepia</td>
<td>94</td>
<td></td>
</tr>
<tr>
<td>Settings</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>Shooting</td>
<td>11, 20, 26</td>
<td></td>
</tr>
<tr>
<td>Shooting Settings 1</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>Shooting Settings 2</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>Shutter speed</td>
<td>36</td>
<td></td>
</tr>
<tr>
<td>Slideshow</td>
<td>39</td>
<td></td>
</tr>
<tr>
<td>Slow Synchro</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Smart zoom</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>Smile Detection Sensitivity</td>
<td>83</td>
<td></td>
</tr>
<tr>
<td>Smile Shutter</td>
<td>23</td>
<td></td>
</tr>
<tr>
<td>Snow</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td>Soft Focus</td>
<td>106</td>
<td></td>
</tr>
<tr>
<td>Soft Snap</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td>Software</td>
<td>134, 141</td>
<td></td>
</tr>
<tr>
<td>Spot AF</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>Spot metering</td>
<td>33</td>
<td></td>
</tr>
<tr>
<td>Spot metering cross hairs</td>
<td>33</td>
<td></td>
</tr>
<tr>
<td>SteadyShot</td>
<td>95</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temporarily Rotated Display</td>
<td>44</td>
<td></td>
</tr>
<tr>
<td>Time Zone</td>
<td>117</td>
<td></td>
</tr>
<tr>
<td>Touch panel</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Trimming</td>
<td>106</td>
<td></td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>150</td>
<td></td>
</tr>
<tr>
<td>TV</td>
<td>128</td>
<td></td>
</tr>
<tr>
<td>TV TYPE</td>
<td>66</td>
<td></td>
</tr>
<tr>
<td>Twilight Portrait</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td>Twilight</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td>U</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unsharp masking</td>
<td>106</td>
<td></td>
</tr>
<tr>
<td>Upload Images/Browse the Web</td>
<td>121</td>
<td></td>
</tr>
<tr>
<td>USB Connect</td>
<td>62</td>
<td></td>
</tr>
<tr>
<td>Using the camera abroad</td>
<td>167</td>
<td></td>
</tr>
<tr>
<td>V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VGA</td>
<td>76</td>
<td></td>
</tr>
<tr>
<td>Video Out</td>
<td>65</td>
<td></td>
</tr>
<tr>
<td>View Images 1</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>View Images 2</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>View Mode</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>Vivid</td>
<td>94</td>
<td></td>
</tr>
<tr>
<td>Volume Settings</td>
<td>116</td>
<td></td>
</tr>
<tr>
<td>W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Warning indicators and messages</td>
<td>161</td>
<td></td>
</tr>
<tr>
<td>White Balance</td>
<td>88</td>
<td></td>
</tr>
<tr>
<td>Wide Zoom</td>
<td>17, 43</td>
<td></td>
</tr>
<tr>
<td>Windows computer</td>
<td>131</td>
<td></td>
</tr>
<tr>
<td>Z</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td>27</td>
<td></td>
</tr>
</tbody>
</table>
Notes on the License

“C Library”, “Expat” and “zlib” software are provided in the camera. We provide this software based on license agreements with their owners of copyright. Based on requests by the owners of copyright of these software applications, we have an obligation to inform you of the following. Please read the following sections.
Read “license1.pdf” in the “License” folder on the CD-ROM. You will find licenses (in English) of “C Library”, “Expat” and “zlib” software.

On GNU GPL/LGPL applied software

The software that is eligible for the following GNU General Public License (hereinafter referred to as “GPL”) or GNU Lesser General Public License (hereinafter referred to as “LGPL”) are included in the camera.
This informs you that you have a right to have access to, modify, and redistribute source code for these software programs under the conditions of the supplied GPL/LGPL.
Source code is provided on the web. Use the following URL to download it.
http://www.sony.net/Products/Linux/
We would prefer you do not contact us about the contents of source code.

Read “license2.pdf” in the “License” folder on the CD-ROM. You will find licenses (in English) of “GPL”, and “LGPL” software.
To view the PDF, Adobe Reader is needed. If it is not installed on your computer, you can download it from the Adobe Systems web page:
http://www.adobe.com/
Password release number

For details on the Password Lock function, see page 67.
To release the password lock of the camera, enter the following number.
“7669”